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Введение
Поздравляем Вас с покупкой RPx400.
RPx400 представляет собой прорыв в технологии гитарной обработки.
Если вы хотите как следует разобраться в возможностях RPx400, просто  внимаетльно 
прочитайте данное Руководство, имея процессор перед глазами.

Комплектующие
Перед началом использования, убедитесь в наличии всех комплектующих:

• Гитарный процессор RPx400
• Диск с программным обеспечением X-Edit software
• USB-кабель
• Адаптер питания PS0913B
• Гарантийный талон

Мы позаботились о всех ваших запросаз при производстве RPx400.  Все комплектующие 
должны быть в наличии и работать исправно. В случае неполной комплектации 
необходимо немедленно обратиться к производителю. Чтобы мы могли ознакомиться 
с вашими потребностями и пожеланиями – заполните гарантийный талон. Он также 
дает право на сервисное обслуживание, если с вашим RPx400 возникнут проблемы.

1. Напольные переключатели – используются для выбора пресетов, для входа в режим 
тюнера, а также в режим bypass. Левый переключатель позволяет перейти на 
один пресет назад, средний переключатель – переключает на пресет вперед. 
При нажатии на оба переключателя включается режим bypass. Чтобы включить 
тюнер – нажмите и задержите оба переключателя.

Introduction
Congratulations on your purchase of the RPx400. The RPx400 is truly a breakthrough in guitar processing
technology, providing the tools you need for live performance and the professional features you need in the
recording studio. We recommend that you take the time to become better acquainted with what the
RPx400 has to offer by going through this User’s Guide with your RPx400 in front of you.

Included Items
Before you get started, please make sure that the following items have been included:

• RPx400 Modeling Guitar Processor
• X-Edit Software CD
• USB Cable
• PS0913B Power Supply
• Warranty Card

The utmost care was taken while your RPx400 was being manufactured. Everything should be included
and in perfect working order. If anything is missing, contact the factory at once. Please help us become
acquainted with you and your needs by completing your warranty card. It is your safeguard should a prob-
lem arise with your RPx400.

The Front Panel

1. Down/Up Footswitches - These two footswitches are used to select presets, access the Tuner, or bypass
the RPx400. The footswitch on the left decreases, and the middle footswitch increases the pre-
set number. Pressing both footswitches together bypasses the selected preset. Press and hold
both Footswitches to access the Tuner.

1

Introduction

Передняя панель



2. Переключатель Amp A/B. Этот переключатель меняет два канала усилителя для 
выбранного пресета. Также он используется вместе с переключателем Up, 
для доступа к режиму Learn-A-Lick и функциям записи (когда процессор 
подключен к компьютеру через USB).

3. Регуляторы. Эти регуляторы выполняют различные функции, в зависимости от 
выбранного режима или если RPx400 подключен к компьютеру посредством 
USB. Во время игры регуляторы контролируют уровень громкости усилителя, 
эквалайзер низких, средних и высоких частот, а также мастер-уровень. Если 
RPx400 подключен к компьютеру – регуляторов 2, 3 и 4 соответственно отвечают 
за уровень аккомпанемента, уровень звука сигнала, посылаемого на выход 
USB 1-2 и USB 3-4. При работе с функциями Настроек регуляторы устанавливают 
значения параметров для выбранного эффекта. Обозначения параметров 
находятся непосредственно над каждым регулятором. В режиме драм-машины 
регуляторы отвечают за номер паттерна, темп и уровень громкости. В режиме 
тюнера регуляторы используются для выбора опорного тона настройки.

4. Кнопка Select. Эта кнопка служит для открытия режима Редактирования и выбора 
индивидуальных эффектов для их последующего изменения. Многократное 
нажатие этой кнопки позволяет последовательно переходить от одного 
эффекта к другому. Кроме этого она используется для изменения скорости 
воспроизведения в режиме Learn-A-Lick

5. Drums. Кнопка Drums включает и выключает встроенную драм-машину. Когда драм-
машина включена – загорается диод Drums и начинается непрерывное 
воспроизведение выбранного барабанного паттерна.

6. Матрица. Матрица представляет из себя таблицу, содержащую информацию 
относительно текущего пресета, параметров и функций редактирования. В 
Режиме Выступления диоды показывают какой эффект используется в данный 
момент. В Режиме Редактирования диодом отмечается редактируемый 
эффект.

7. Дисплей. На дисплее отображается информация о различных функциях в зависимости 
от действующего режима. В Режиме Выступления на дисплее показаны 
название выбранного пресета и его номер. В Режиме Редактирования 
дисплей показывает название и значение выбранного параметра. В Режиме 
Тюнера на дисплее видно название воспроизводимой в данный момент 
ноты, и ее отклонение от настройки (в меньшую сторону, в большую сторону, 
настроена).

8. Кнопка Store. Кнопка Store сохраняет изменения в Пользовательский Пресет.
9. Педаль экспрессии. Педаль экспрессии позволяет в реальном времени регулировать 

некоторые встроенные Параметры Эффектов процессора RPx400. Практически 
каждый Параметр можно контролировать Педалью Экспрессии.

2. Amp A/B Footswitch - This footswitch switches between two amp channels for the selected preset. It is
also used in conjunction with the Up Footswitch, to access Learn-A-Lick, or the recorder func-
tions when the RPx400 is connected to your computer via USB.

3. Knobs - These knobs perform various functions depending on which mode is selected or whether the
RPx400 is connected to your computer via USB. During performance, the knobs control the
Amp Gain, Bass EQ, Mid EQ,Treble EQ, and Master Level. If the RPx400 is connected to the
computer via USB, the performance functions of knobs 2, 3, and 4 are Playback Mix, USB 1-2 Send
Level, and USB 3-4 Send Level. When editing or accessing the Setup functions, the knobs adjust
the parameter values listed directly above each knob for the selected effect. When the Drum
Machine is on, the knobs control the Pattern,Tempo, and Level. In Tuner mode, the knobs are
used to select the tuning reference.

4. Select Button - This button enters the Edit mode, and selects individual effects to be edited. Successive
presses of this button advances through all available effects. It is also used to change play-
back speed in Learn-A-Lick mode.

5. Drums - The Drums button turns the built-in drum machine on and off. When the drum machine is
active, the Drums LED lights and the selected drum pattern plays continuously.

6. Matrix - The matrix provides information regarding the current preset, and parameter edit functions. In
performance mode, the LEDs running down the left side of the Matrix identify which effects are
in use for the selected preset. In Edit mode, the LEDs indicate the effect selected for editing.

7. Display - The display provides information for different functions depending on the mode that is active. In
Performance mode, the display shows the selected preset name and numeric location. In Edit
mode, the display shows the name and value of the selected parameter. In Tuner mode, the dis-
play shows the note being played and whether the note is sharp, flat, or in tune.

8. Store - The Store button saves your changes to a User Preset.

9. Expression Pedal - The Expression Pedal adjusts the RPx400’s assigned Effect Parameter in real time.
Almost every Parameter is available for Expression Pedal control.

Rear Panel

1. Guitar In - Connect your instrument to this jack.
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1. Guitar In. Джековое гнездо для подключения инструмента.
2. Mic Level. Отвечает за уровень громкости подключенного микрофона.
3. Mic Input. Гнездо подключения микрофона служит для создания записи или 

микширования внешних акустических источников во время живого выступления. 
RPx400 позволяет обрабатывать микрофонный сигнал имеющимися эффектами, 
как во время записи, так и во время выступления. Вход микрофона совместим 
с динамическими и конденсаторными микрофонами с фантомным питанием.

4. Линейные входы Left/Right. Служат для подключения внешних линейных источников 
для микширования с RPx400 во время записи или выступления. Внешние 
линейные сигналы могут воспроизводиться в чистом виде или  обработанными 
эффектами процессора.

5. Гнездо входа CD/Monitor. Служит для соединения выходного джека СD или МР3-
плеера с процессором во время работы в режиме Learn-A-Lick Phrase Train-
er (подробнее о функции Learn-A-Lick см. стр.8). Этот вход также может быть 
использован в качестве мониторного входа для микширования звуков RPx400 
с выходным сигналом звуковой карты Вашего компьютера для мониторинга 
дорожки воспроизведения.

ПРИМЕЧАНИЕ: При использовании входа CD/Monitor для любого типа записи в реальном времени 
может возникнуть задержка звука (зависит от скорости компьютера).

6. Вход для наушников. 1/8” джековое гнездо используется для подключения 
стереонаушников.

7. 1/4” линейные выходы. Используются для соединения с усилителем или микшерским 
пультом, поддерживающим несбалансированные 1/4” соединения. 
При соединении с полнодиапазонной акустической системой имеется 
возможность использовать функцию Speaker Compensation (подробнее о 
функции Speaker Compensation см. стр.23).

8. Сбалансированные линейные выходы. Используются для соединения с усилителями и 
акустическими системами с высокой мощностью или с микшерскими пультами, 
поддерживающими сбалансированную XLR-коммутацию. При соединении с 
полнодиапазонной акустической системой имеется возможность использовать 
функцию Speaker Compensation (подробнее о функции Speaker Compensation 
см. стр.23).

9. Входное гнездо USB. Используется для соединения процессора с USB-портом 
компьютера при записи (подробнее о функциях USB см. стр. 25)

ВНИМАНИЕ: Перед подключением RPx400 к вашему компьютеру установите USB-драйверы, 
прилагающиеся на диске X-Edit Software. Это послужит гарантией того, что программа Pro-Tracks™ 
опознает процессор как источник записи звука.

10. Гнездо питания. Подключайте только прилагаемый адаптер PS0913R.
11. Footswitch. Используйте это гнездо для подключения трехкнопочного напольного 

переключателя RPxFC. Переключатель RPxFC позволяет осуществлять 
дистанционное управление функциями записи RPx400 (подробнее о функциях 
RPxFC см. стр. 35)



Коммутация
Существуют несколько вариантов коммутации RPx400. Перед подключением убеди-
тесь в том, что усилитель и процессор выключены. RPx400 не имеет кнопки включе-
ния. Чтобы выключить RPx400 необходимо отсоединить прилагаемый адаптер питания 
PS0913S от сети.

Making Connections
There are several different connection options available with the RPx400. Before connecting the RPx400,
make sure that the power to your amplifier and the RPx400 is turned off. The RPx400 does not have a
power switch. To turn the RPx400 off, disconnect the included PS0913B power supply from the power jack
to an AC outlet.

Mono Amp Rig
Connect your guitar to the Input of the RPx400. Connect a single mono instrument cable from the Left
1/4” Line Output of the RPx400 to the instrument input or effect return on your amplifier. This connec-
tion scheme also applies for use with a power amp/speaker cabinet rig.

Stereo Amp Rig
Connect your guitar to the Input of the RPx400. Connect a two mono instrument cable from the Left
and Right 1/4” Line Outputs of the RPx400 to the instrument inputs or effect returns on each of your
amplifiers. This connection scheme also applies for use with a power amp/speaker cabinet rig.

NOTE: When using a guitar amp, it may be best to connect the guitar to the Input of the
RPx400 and the Output of the RPx400 to the effect return of the amplifier to avoid
coloration of the tone due to the amplifier’s tone controls.
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Стереоусилитель
Подключите гитару к входному гнезду RPx400. Посредством двух инструментальных 
моно-кабелей соедините левый и правый 1/4” Линейные Выходы процессора с вход-
ными гнездами инструмента или к разъемам возврата эффектов на двух усилителелях. 
Такая схема также подходит для использования с гитарным кабинетом высокой мощ-
ности.

ПРИМЕЧАНИЕ: Чтобы избежать изменения звука, вызванного контроллерами регулировки тона 
на усилителе, лучше всего подключать гитару к входному гнезду RPx400, а выходные гнезда 
процессора – к разъему возврата эффектов.

Моноусилитель
Подключите гитару к входному гнезду RPx400. Посредством инструментального моно-
кабеля соедините 1/4” Левый Линейный Выход процессора с входным гнездом инс-
трумента или к разъему возврата эффектов на усилителе. Такая схема также подходит 
для использования с гитарным кабинетом высокой мощности.



Усилитель/ Микшерский пульт
Подключите гитару к входному гнезду RPx400. Соедините один из 1/4” Линейных Выхо-
дов процессора инструментальным моно-кабелем с входным гнездом инструмента 
или к разъему возврата эффектов на усилителе/усилителе высокой мощности. Под-
ключите сбалансированные XLR-выходы к РА-микшеру и разведите каждый из каналов 
по панораме до конца налево и направо соответственно. Выберите SC XLR в качестве 
Формы Выхода (подробнее об Output Modes см. стр. 23). Это позволит задействовать 
Симуляцию Кабинета на микшер и РА (не действует на гитарный усилитель). Такая схе-
ма также подходит для использования с гитарным кабинетом высокой мощности.

Amp / PA Rig
Connect your guitar to the Input of the RPx400. Connect a a mono instrument cable from the Left or
Right 1/4” Line Output of the RPx400 to the instrument input or effect return on your amplifier or
power amp/speaker cabinet rig. Connect the balanced XLR Left and Right outputs to the inputs on your
PA mixer and pan each of these channels hard left and hard right. Select SC XLR as your Output Mode
(see Output Modes on pg 23). This enables Cabinet Simulation on the feeds to the mixer and PA but
not to your guitar amp onstage. This connection scheme also applies for use with a power amp/speaker
cabinet rig.

Recording Setup
This is the classic recording setup utilizing the RPx400’s mic and line inputs and a pair of powered refer-
ence monitors connected the RPx400’s XLR outputs. This setup can also be used for live applications
where you would be performing along with playback from the Pro Tracks. recording software running on
your computer. See the Output Modes section on page 23 on how the XLR and 1/4” outputs and
Speaker Compensation can be implemented for various recording and live applications
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Запись
Это классический вид установки с использованием микрофонного и линейного входа 
RPx400 и пары мониторов, соединенных с XLR-выходами процессора. Такая комму-
тация может быть использована для выступления в сопровождении звукового ряда, 
проигрываемого программой Pro-Tracks™ с компьютера. Ознакомьтесь с разделом 
Output Modes на странице 23 для подробной информации о применении XLR-выхо-
дов, 1/4” выходов и функции Speaker Compensation во время записи и выступлений.
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Подключение процессора к сети
Перед подключением к сети установите чистый звук на усилителе, а также поставьте 
контроллеры тона на чистый (на большинстве усилителей это соответствует отметке 0 
или 5 на регуляторах контроля тона).

Applying Power 
Before applying power to anything, set your amp(s) to a clean tone and set the tone controls to a flat EQ
response (on most amps, this would be 0 or 5 on the tone controls). Then do the following:
1. Turn the amp volume all the way down.
2. Connect the plug of the PS0913B power supply to the Power Jack.
3. Connect the other end of the PS0913B power supply to an AC outlet and turn the Master Level knob

until the display reads mlevel 0.
4. Turn your amplifier(s) on and adjust the volume(s)to a normal playing level.
5. Gradually increase the RPx400’s Master Level to the desired listening level.

Connect PS0913B to AC Outlet
and turn the RPx400 Master Volume
down.

Turn the RPx400 Master Volume
up to the desired listening level.
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5. Постепенно поднимайте Master Level 
процессора до необходимого вам уровня.

1. Выключите звук усилителя, 
используя регулятор звука.

2. Соедините кабель адаптера питания 
PS0913S к гнезду питания процессора.

3. Вставьте вилку адаптера питания PS0913S в 
розетку. Поворачивайте регулятор Master Level 
до появления на дисплее надписи MLEVEL 0

4. Включите усилитель и 
поднимите уровень звука на 
нем до необходимого вам 
уровня.



Пресеты
Пресеты – озаглавленные и пронумерованные комплекты запрограммированных 
звуков, встроенные в RPx400. Пресеты вызываются напольными переключателями. 
Горящий диод в Матрице Эффектов показывает на активные эффекты в каждом 
пресете. Процессор RPx400 поставляется с 40 Пользовательскими пресетами (Presets 
U1-U40), 40 Артистических пресетов (Presets А1-А40) и 40 Заводских пресетов DigiTech 
(Presets F1-F40). Параметры Пользовательских пресетов доступны для редактирования 
пользователем. Вы не можете сохранять изменения в Артистические/Заводские 
пресеты. По умолчанию 40 Пользовательских пресетов в точности дублируют 
Артистические.

Режим Выступления
При первом подключении к сети, RPx400 включается в Режиме Выступления. В этом 
режиме обеспечен доступ ко всем пресетам посредством Переключателя. Регулятор 
1 (слева) устанавливает уровень громкости для выбранного типа усилителя, Регулятор 
2 (второй слева) устанавливает количество низких частот, Регулятор 3 (в центре) 
устанавливает количество средних частот, Регулятор 4 (второй справа) устанавливает 
количество высоких частот, регулятор 5 (справа) устанавливает Master Level.

Необработанный Сигнал
Для получения необработанного гитарного звука, эффекты пресетов RPx400 могут быть 
отключены. Чтобы получить необработанный звук необходимо нажать одновременно 
Переключатели Up и Down. При отключении эффектов на дисплее появится надпись By-
pass. Нажатие на любой из трех Переключателей отменяет эффект необработанного 
звука и возвращается к выбранному ранее пресету.

Тюнер
Тюнер позволяет быстро настроить или проверить настройку гитары. Зажмите и 
удержите Переключатели Up и Down для входа в Режим Тюнера. После этого на 
дисплее должно появиться оповещение о входе в Режим Тюнера. Чтобы начать 
настройку сыграйте ноту на гитаре (лучше всего – гармонию на 12 ладу). Два правых 
знака на дисплее показывают ноту, которая звучит в данный момент. Знаки в левой 
части дисплея показывают повышение или понижение тона в данный момент. Стрелки, 
направленные влево (<<<) показывают, что тон завышен и нуждается в понижении. 
Стрелки, направленные вправо (>>>) показывают, что тон занижен и нуждается в 
повышении. Когда нота настроена точно, на дисплее изображено >>><<<.

The Presets
Presets are named and numbered locations of programmed sounds which reside in the RPx400. Presets are
recalled with the footswitches. The active effects in each preset are indicated by the lighted LEDs in the
Effect Matrix. The RPx400 comes with 40 User Presets (Presets U1-U40), 40 Factory Artist Presets (Presets
A1-A40), and 40 DigiTech factory presets (F1-F40). The User Presets are locations where you can store your
edits. You may not store changes to the  Artist/Factory Presets. From the factory, the 40 User Presets are
exact duplicates of the 40 Factory Artist Presets.

Performance
When you first apply power to the RPx400, it powers up in Performance mode. Performance mode provides
access to all of the presets within the RPx400 via the Up and Down Footswitches. The Number 1 Knob
(left) adjusts the Gain for the selected Amp Type, the Number 2 Knob (second from the left) adjusts the
amount of Bass enhancement, the Number 3 Knob (middle) adjusts the amount of Mid-range enhancement,
the Number 4 Knob (second from the right) adjusts the amount of Treble (high frequency) enhancement, and
the Number 5 Knob (right) adjusts the Master Level (volume).

Bypass
The RPx400 Presets can be bypassed for a clean, unprocessed guitar tone. To bypass the RPx400, press both
the Up and Down Footswitches simultaneously. The display read Bypass indicating the preset is bypassed.
Pressing any of the 3 Footswitches exits Bypass and returns the RPx400 to the previously selected preset.

Tuner
The Tuner lets you quickly tune or check the tuning on your guitar. Enter Tuner mode by pressing and hold-
ing the Up and Down Footswitches simultaneously. The display briefly shows tuner indicating that you are in
Tuner mode. To begin tuning, play a note on your guitar (a harmonic at the 12th fret usually works best).
The right 2 characters in the display shows the note being played. The  left characters in the display indicate
whether you are sharp or flat. Arrows pointing to the left (<<<) indicate the note is sharp and should be
tuned down. Arrows pointing to the right (>>>) indicate the note is flat and should be tuned up. When the
note is in tune, the display shows >>><<<.

In Tuner mode, you can change your tuning reference. The default factory setting is A=440 Hz. (displayed as
A=440). Rotate the Number 1 Knob to select alternate dropped tunings. Alternate tunings are A = Ab ,A =
G , and A = Gb. The display window briefly flashes the selected tuning preference.

The output is muted in Tuner mode. The Expression Pedal returns sound to the output allowing signal to be
heard while tuning. Exit tuner mode by pressing any of the 3 Footswitches.

>>><<< A

7

Introduction

В режиме Тюнера можно менять стандарт настройки. Заводские параметры – А=440 
Hz (показано как А=440). Поворачивайте Регулятор 1, чтобы выбрать дополнительные 
варианты настройки. Дополнительные варианты – А=Аb, А=G, A=Gb. Окно дисплея 
отображает выбранное предпочтение коротким миганием.
В Режиме Тюнера звуковой сигнал не поступает на выход. Услышать сигнал во время 
настройки можно при нажатии Педали Экспрессии, выводящей звук на выход. Выход из 
Режима Тюнера осуществляется нажатием любого из трех переключателей.



Режим Learn-A-Lick
Learn-A-Lick позволяет записывать 10секундный музыкальный отрезок и проигрывать 
его без изменения высоты тона до 1/4” от изначальной скорости. Это может быть по-
лезно при подборе нот в быстрых сольных частях.
В режиме Learn-A-Lick доступны 6 функций:

• Stop (управляется Переключателем Down)
• Rewind (управляется Переключателем Up)
• Play (управляется Переключателем Down)
• Record (управляется Amp A-B)
• Playback Speed (управляется кнопкой Select)
• Sampled Phrase Volume (управляется Педалью Экспрессии)

Использование Learn-A-Lick
1. Соедините выходное гнездо наушников CD/MP3/кассетного плеера с входным гнез-

дом CD/Monitor на задней панели (с помощью 1/8” стерео шнура). Поднимите 
уровень громкости CD/MP3/кассетного плеера до необходимого.

2. Выберите фрагмент, который вы хотите записать и нажмите кнопку паузы на плеере.
3. Зажмите Переключатели Up и A-B для входа в Режим Learn-A-Lick. На дисплее появит-

ся LALICK.
4. Когда на дисплее появится READY возобновите воспроизведение на плеере, а за-

тем нажмите Переключатель Amp A-B (Record). Начнется процесс записи, а 
на дисплее отобразится RCRDNG. Две правые цифры на дисплее показыва-
ют истекшее время записи. После окончания записи, RPx400 входит в режим 
циклического  воспроизведения отрезка (на дисплее показано Play). Нажмите 
кнопку паузы или остановки воспроизведения на CD/MP3/кассетном плеере.

5. Используйте кнопку Select для выбора корости воспроизведения. Моногократное 
нажатие кнопки Select устанавливает варианты скорости воспроизведения от 
1/4” до оригинальной скорости. Доступны следующие варианты: 1/4”, 3/8, 1/4, 
5/8, 1/4, 7/8 и оригинальная (Full).

6. Нажмите на Переключатель Up. В течение одной секунды произойдет переход на на-
чало отрезка.

7. Педаль Экспрессии контролирует выходной уровень звука записанного отрезка.
8. Для остановки или повторного воспроизведения нажмите Переключатель Down (Stop/

Play).
9.    Для записи нового отрезка нажмите Переключатель Amp A-B (Record) снова.
10. Для выхода из Режима Learn-A-Lick зажмите одновременно Переключатели Up и Amp 

A-B.

ПРИМЕЧАНИЕ: Режим Learn-A-Lick недоступен, когда RPx400 подключен к компьютеру через USB.

Вход CD/Monitor
Функция CD In позволяет вам подключить CD, MP3 или кассетный плеер к RPx400 для 
игры поверх записей ваших любимых музыкантов. Для использования функции CD In 
необходимо:

1. Соединить выходное гнездо наушников CD/MP3/кассетного плеера с входным гнез-
дом CD/Monitor на задней панели (с помощью 1/8” стерео шнура).

2. Начать воспроизведение (Play) на вашем CD/MP3/кассетном плеере. Сигнал с плее-
ра направлен в левый и правый выход, а также в выход наушников процессора 
RPx400.



Драм-машина.
Встроенная в RPx400 драм-машина содержит несколько семплов барабанных пат-
тернов, полезных для развития ритмичности и чувства времени. Драм-машина включа-
ется нажатием кнопки Drums (за исключением режимов Store и Bypass). При влючен-
ной драм-машине:
Регулятор 1 отвечает за выбор барабанного паттерна. Доступны следующие паттер-
ны:

ROCK 1	 HROCK 4	 DANCE 1	 BLUES 2	 URBAN 1
ROCK 2	 POP 1	 DANCE 2	 JAZZ	 URBAN 2
ROCK 3	 POP 2	 DANCE 3	 FUNK 1	 REGGAE
HROCK 1	 POP 3	 CNTRY 1	 FUNK 2	 CHA 1
HROCK 2	 POP 4	 CNTRY 2	 SWING 1	 CHA 2
HROCK 3	 POP 5	 BLUES 1	 SWING 2	 BOSSA
				    MTRNOM

Регулятор 2 контролирует темп паттерна от 40 ударов в минуту (ВРМ 40) до 240 ударов 
в минуту (ВРМ 240).
Регулятор 3 контролирует уровень звука барабанного лупа (от 1 до 99).
При повторном нажатии кнопки Drums воспроизведение барабанного лупа останав-
ливается.

Mic Input & Level
Микрофонный вход RPx400 может использоваться для записи вокала и акустических 
инструментов. Микрофонный вход обеспечен фантомным питанием для профессио-
нальных конденсаторных микрофонов. Микрофонный предусилитель контролирует 
уровень громкости микрофонного сигнала (с помощью Регулятора Level). Чтобы на-
строить уровень микрофонного сигнала необходимо:

1. Подключить наушники к джековому гнезду наушников.
2. Установите самый громкий звук, который будет использоваться во время выступле-

ния. Отрегулируйте уровень до исчезновения слышимых искажений звука. Данный 
вид настройки оптимален для Mic Level.

Подробнее о возможностях использования микрофонного входа описано в разделах 
Коммутация и Установки RPx400.



СОЗДАНИЕ ПРЕСЕТОВ
Создание/Редактирование пресетов

Создание собственного звучания на процессоре RPx400 – интуитивно понятный 
и простой процесс. RPx400 позволяет вам создать собственные пресеты либо 
изменить уже существующие исходя из музыкальных пристрастий. Создавать или 
редактировать звук необходимо на основе Пользовательских, Артистических или 
Заводских пресетов. Начать работу с пустого пресета невозможно. Каждое новое 
изменение пресета можно сохранить в любом из Пользовательских пресетов.

Для создания или редактирования пресета:
1. Используйте Переключатель Up или Down для выбора пресета.
2. После того, как вы выбрали пресет для редактирования, нажмите кнопку Select для 

входа в Режим Редактирования.
3. Используя кнопку Select, выберите эффект для редактирования в соответствии с горя-

щим диодом на Матрице. Многократное нажатие на кнопку Select позволяет 
последовательно перейти от одного эффекта к другому.

4. Используйте Регулятор 5 для изменения значения параметра.
5. Сохраните ваш пресет. Ознакомьтесь с данной страницей для получения дополни-

тельной информации по сохранению пресетов.

Creating Presets
Editing/Creating Presets
Creating your own signature sound with the RPx400 is easy and intuitive. The RPx400 lets you create your
own presets, or fine tune existing presets to suit your needs. When creating or editing a sound, you must
start with one of the User, Artist Factory, or Factory Presets. It is not possible to start with an empty pre-
set. The preset number does not need to be the location that you intend to save it to, because you can save
it to any User Preset location during the store process.

To edit or create a Preset:
1. Use the Up or Down Footswitches to select a preset.
2. Once you have found a preset that you want to edit, press the Select button once to enter Edit mode.
3. Use the Select button in conjunction with the Matrix LEDs to choose the effect you want to edit.

Successive presses of the Select button advance to the next Effect in the Matrix.
4. Use the 5 Knob to change parameter values.
5. Store your preset. See this page for more on storing a preset.

The Matrix
The Matrix identifies the effects and parameters selected for editing. In Edit mode, successive presses of the
Select button advance to the next row of effects. The LED lights indicating which effect group is selected.
Each effect group has up to 5 parameters that can be modified. The knob directly below each column is used
to change the parameter value of the selected effect. As a knob is rotated, the corresponding parameter’s
name and value or status are displayed.

When the stored value of a parameter is changed, the Store LED lights indicating you need to store the
changes. Changing presets, or turning the power off before storing erases all changes made and the RPx400
reverts to the stored values for the preset.

Storing/Copying/Naming a Preset
Once the preset is modified, you may store your settings to any of the 40 User Preset locations (Presets U1-
U40). The following steps outline the procedure for storing changes to a preset or copying a preset to a dif-
ferent location:
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Используйте кнопку 
Select для выбора 
эффекта.

Над каждым Регулятором указан параметр, 
доступный для изменения.

Матрица
На  vатрице  отображен  список эффектов и параметров, доступных для редактиро-
вания. В Режиме Редактирования многократное нажатие кнопки Select обеспечивает 
переход на следующий ряд эффектов. Диод загорается рядом с выбранной группой 
эффектов. Каждая группа эффектов включает в себя до 5 параметров, доступных для 
редактирования. Регулятор, расположенный под столбцом используется для изме-
нения значения параметров выбранного эффекта. По мере поворота Регулятора, на 
дисплее отображается имя, значение или статус, соответствующий выбранному па-
раметру.

После изменения исходного значения параметра загорается диод Store, указываю-
щий на необходимость сохранить изменения. Если изменения не сохранены, при вы-
ключении или изменении пресета, все значения сбрасывается до исходных.

Сохранение/Копирование/Озаглавливание пресетов
После внесения изменений в пресет, вы можете сохранить настройки в любой из 40 
локаций Пользовательских пресетов (U1-U40). Далее описаны действия для внесения 
изменений в пресет и копирования пресета в различные локации.



1. Press the Store button once. The Store button LED blinks and the first character in the display flashes
indicating you can name your new preset.

2. Use the Number 1 Knob or Up/Down Footswitches to select the alpha-numeric character.
3. Rotate the Number 2 Knob clockwise to select the next character, and counterclockwise to select the

previous character. Repeat step 2 until the name is complete.

4. Once the name is shown in the display, press the Store button. The display alternates between the new
name and the name of the preset about to be overwritten.

5. Select the User Preset location of your new preset using the Number 5 Knob or the Up/Down
Footswitches. The display continues to alternate between the new preset name and name of the preset
about to be overwritten.

6. Press the Store button again to save the changes.

Press the Select or Drums buttons at any time to abort storing.

To copy one preset to another preset location is the same as above. Use the footswitches to select the pre-
set that you want to copy, then follow the steps listed above.
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6. Для сохранения изменений нажмите кнопку Store еще раз. Нажмите кнопку Select или 
Drums, если хотите прервать операцию сохранения. Копирование пресета 
в локацию другого пресета происходит по принципу, описанному выше. 
Выберите пресет, который вы хотите скопировать (с помощью Переключателей), 
а затем следуйте вышеперечисленным пунктам.

1. Press the Store button once. The Store button LED blinks and the first character in the display flashes
indicating you can name your new preset.

2. Use the Number 1 Knob or Up/Down Footswitches to select the alpha-numeric character.
3. Rotate the Number 2 Knob clockwise to select the next character, and counterclockwise to select the

previous character. Repeat step 2 until the name is complete.

4. Once the name is shown in the display, press the Store button. The display alternates between the new
name and the name of the preset about to be overwritten.

5. Select the User Preset location of your new preset using the Number 5 Knob or the Up/Down
Footswitches. The display continues to alternate between the new preset name and name of the preset
about to be overwritten.

6. Press the Store button again to save the changes.

Press the Select or Drums buttons at any time to abort storing.

To copy one preset to another preset location is the same as above. Use the footswitches to select the pre-
set that you want to copy, then follow the steps listed above.

11

Creating Presets

1. Нажмите кнопку Store. После 
этого загорается диод Store, а 
первый символ названия пресета 
на дисплее начинает мигать.

2. Используйте Регулятор 1 или 
Переключатели Up/Down для 
выбора первого символа.

3. Для перехода на следующий символ, поворачивайте 
Регулятор 2 по часовой стрелке. Для перехода на 
предыдущий символ, поворачивайте Регулятор 
2 против часовой стрелки. Повторяйте шаг 2 до 
установления название пресета.

4. Нажмите кнопку Store, когда 
заданное название отображается 
на дисплее. На дисплее начнут 
поочередно отображаться новое 
название и название пресета, 
который вы собираетесь изменить.

5. Выберите локацию для 
измененного пресета из набора 
Пользовательских Пресетов, 
используя Регулятор 5 или 
Переключатели Up/Down,. Дисплей 
по-прежнему будет поочередно 
отображать новое название и 
название пресета, который вы 
собираетесь изменить.



RPx400’s Effects
About the Effects
The RPx400 can be thought of as several different “virtual” amplifiers and individual, hi-tech stomp boxes in a
single programmable package. With stomp boxes, the order in which they are connected can drastically affect
the overall sound quality. The RPx400 has placed the effects in an order for optimum sound quality. The fol-
lowing diagram shows the order of the effects.

Effect Definitions
Each effect within the RPx400 can be programmed to suit your personal taste and application. Understanding
how these effects alter the sound, and how each parameter alters the effect helps you achieve the sound you
are looking for. The following overview of the RPx400’s effects outlines what each effect and parameter does.

Pickup/Wah 
The Pickup Simulator provides the thick tone of a humbucker pickup to a guitar with single coil pickups,
or the bright edgy sound of a single coil pickup to a guitar with a humbucker. This lets you have the best
of both worlds without having to change guitars during a performance.

Wah is an effect controlled by the Expression Pedal. As the Expression Pedal is rocked back and forth, it
makes the guitar sound as if it is saying “Wah.” The Wah is engaged and disengaged by applying pressure
to the V-Switch located under the toe of the Expression Pedal. See Page 21 for more information regard-
ing the V-Switch.
Pickup Off/Type - The Number 1 Knob selects the type of Pick Up to be be simulated. Values include:

SC>HUM (Gives a single coil pick up the warm tone of a humbucker), and HUM>SC
(Gives a humbucker the unique sound of a single coil), or turns Pickup Simulation off.

Wah On/Off- The Number 2 Knob turns the Wah effect on or off.
Wah Type - The Number 3 Knob selects the type of Wah. Values include: CRY (Cry Wah is a traditional

sounding Wah), BOUTIQ (Boutique Wah is a wide sweeping Wah with a more modern sound)
and FULRNG (Full Range Wah sweeps the entire spectrum of audible frequencies).

Wah Minimum - The Number 4 Knob is used to select the minimum point the Wah reaches in the toe up
position of the Expression Pedal. Ranges from 1 to 99.

Wah Maximum -  The Number 5 Knob is used to select the maximum point the Wah reaches in the toe
down position of the Expression Pedal. Ranges from 1 to 99.

Compressor 
A Compressor is used to increase sustain, tighten up the guitar signal, and prevent the signal from clip-12
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Описание эффектов
Каждый эффект процессор может быть изменен для удовлетворения вашего персонального 
вкуса и потребностей. Понимание того, как использование эффектов влияет на звук, а измене-
ние параметров влияет на эффект, поможет найти звучание, подходящее именно вам. Далее 
описаны свойства эффектов и параметров.

Pickup/Wah
Симулятор звукоснимателя позволяет получить плотный звук датчика с двумя катушками 
(humbucker) на гитаре где установлен датчик с одной катушкой (single), или же получить более 
прозрачный звук однокатушечного звукоснимателя (single) на гитаре с двухкатушечным датчи-
ком (humbucker). Это позволит вам использовать все многообразие звучания, не меняя инстру-
мент в процессе выступления.

Эффект Wah контролируется Педалью Экспрессии. В соответствии с движением Педали вверх 
или вниз – гитара издает звук, похожий на …. Усиление и ослабление эффекта Wah зависит от 
давления на переключатель V-Switch, находящийся под передней частью Педали Экспрес-
сии. Подробную информацию о V-Switch читайте на стр. 22.
Pickup Off/Type – Регулятор 1 отвечает за выбор типа звукоснимателя для последующей его 

симуляции. Возможные варианты: SC>HUM (придает гитаре с однокатушечным 
звукоснимателем теплое звучание датчика с двумя катушками) HUM>SC 
(придает гитаре с двухкатушечным звукоснимателем уникальное звучание 
датчика с одной катушкой).

Симуляция Звукоснимателя отключена
Wah On/Off – Регулятор 2 включает и выключает эффект Wah.
Wah Type – Регулятор 3 отвечает за выбор типа эффекта. Возможные варианты:
CRY (Cry Wah – эффект с традиционным звуком)
BOUTIQ (Boutique Wah – эффект с современным звуком и более широким частотным охватом)
FULRNG (Full Range Wah – охватывающий весь спектр частот)
Wah Minimum - Регулятор 4 используется для выбора минимального значения эффекта (при 

поднятой Педали Экспрессии). Доступны значения от 1 до 99.
Wah Maximum - Регулятор 4 используется для выбора максимального значения эффекта (при 

опущенной Педали Экспрессии). Доступны значения от 1 до 99.

Эффекты RPx400
RPx400 оснащен несколькими различными виртуальными усилителями и высокотехно-
логичными эмуляциями педалей эффектов в едином программируемом комплекте. Пе-
дали и порядок их подключения могут радикально повлиять на общее качество звуча-
ния. В RPx400 порядок расположения эффектов подобран для оптимального качества 
звука. Следующая диаграмма показывает порядок расположения эффектов.

Симулятор 
датчика Компрессор Wah Whammy

Моделирование 
усилителя Эквалайзер

Эмуляция 
кабинета/

микрофона
Шумоподавление

Шумоподавление 
Педаль звука 
(до обработки 

эффектами)

Эффекты Delay Реверберация

Педаль 
звука (после 

обработки 
эффектами)



Compressor
Компрессор используется для усиления уровня сустейна, для уплотнения гитарного 
сигнала, а также для предотвращения от искажения сигнала другими эффектами. 
Необходимо установить максимальный порог (Threshold) силы сигнала. Если сигнал 
превышает Порог – он регулируется на основе установок уровня компрессии.
Comp On/Off – Регулятор 1 включает (On) и выключает (OF) Компрессор
Attack – Регулятор 2 отвечает за продолжительность временного отрезка, во время 

которого Компрессор реагирует на сигнал, превышающий Порог. Возможные 
варианты: FAST, MEDIUM и SLOW

Ratio – Регулятор 3 устанавливает степень компрессии сигнала после превышения 
Порога. Например, уровень сжатия 4 к 1 означает, что сигнал, превышающий 
Порог на 4 дБ на выходе подвергнется сжатию до 1 дБ. Возможные варианты: 
1.2-1 (1.2 к 1), 1.5-1 (1.5 к 1), 1.8-1 (1.8 к 1), 2.0-1 (2.0 к 1), 2.5-1 (2.5 к 1), 3.0-1 (3.0 к 1), 
4.0-1 (4.0 к 1), 5.0-1 (5.0 к 1), 8.0-1 (8.0 к 1), 10.0-1 (10.0 к 1) и 00-1 (от бесконечности 
до 1).

Threshold – Регулятор 4 отвечает за максимальный уровень поступающего сигнала, до 
его обработки Компрессором. Доступны значения от 1 до 99.

Gain – Регулятор 5 отвечает за уровень звука выходного сигнала из Компрессора. 
Доступны значения от 0 до 6 (дБ).

Моделирование Усилителя/Кабинета
Технология Моделирования Усилителя может придать гитарному сигналу винтажную 
или современную тембровую окраску. Также она позволяет имитировать звучание 
акустической гитары. Раздел Моделирования Усилителя разделяется на два канала 
– канал А и канал В. Каждый канал может быть индивидуально запрограммирован 
с различными настройками уровня перегрузки и уровня громкости Усилителя, Типа 
кабинета, Позиции микрофонов и Эквалайзера. Это позволяет переключаться с чистого 
звука на дисторшн, не изменяя при этом настройки эффектов. Мгновенно переключение 
между каналами Усилителя происходит при нажатии Переключателя А/В.
Кабинетное Моделирование имитирует различные типы miked speaker cabinets. 
Предоставляется возможность выбрать 6 типов кабинетной имитации, к каждому из 
которых прилагаются 4 варианта расположения микрофонов.
Канал Усилителя  –  Регулятор 1 отвечает за выбор каналов (А или В). Во время редактирования 

для выбора канала можно использовать Переключатель А/В. 
Тип Усилителя – Регулятор 2 отвечает за выбор между моделями Усилителя и Акустическим 

Симулятором. Возможные варианты:

DIRECT – имитация усилителя отключена	 CLEAN2 – имитирует ламповый
	 комбо-усилитель без перегрузки 
BKLFAC – на основе ’65 Fender Twin Reverb	 STACK – на основе Marshall JCM900
BOUTIQ – на основе Matchless DC30	 CRUNCH – перегруженный комбик 
RECTIF – на основе Mesa Dual Rectifier	 HIGAIN – на основе Johnson JM150
	 High Gain
НOTROD – на основе Mesa Boogie Mark II C	 FUZZ – fuzz с винтажным звуком 
TWEED – на основе ’57 Fender Tweed Deluxe 	 ACOUST – акустическая гитара
	 с плоской декой.
CLEAN1 – на основе Vox AC30 top boost 
 
Amp Gain – Регулятор 3 отвечает за перегрузку для выбранной Модели Усилителя (кроме 

Акустического Симулятора). Доступны значения перегрузки от 1 до 99.
Amp Level – Регулятор 3 отвечает за уровень звука выбранной Модели Усилителя. 

Доступны значения от 1 до 99.
Cabinet-Mic – Регулятор 5 позволяет выбрать тип модели кабинета и расположение 

микрофонов по отношению к динамику.



The following diagram shows the difference between the Mic 1 through Mic 4 selections:

EQ
Equalization is an extremely useful tool used to further shape the tonal response of  your guitar signal.
The EQ in the RPx400 is similar to the tone knobs on an amplifier. All three EQ parameters range from -
12dB to +12 dB.
EQ On/Off -  The Number 1 Knob turns the EQ on (On) and off (OF).
Bass - The Number 2 Knob adjusts the amount of low end enhancement.
Mid Frequency - The Number 3 Knob selects the frequency to which the boost will be applied by the

mid level knob. Ranges from 500Hz (500 Hz.) to 3000Hz (3000 Hz.)
Mid Level - The Number 4 Knob adjusts the amount of mid range enhancement.
Treble - The Number 5 Knob adjusts the amount of high end enhancement.

Noise Gate
A Noise Gate is designed to eliminate hiss and ambient noise while you are not playing. A Noise Gate
can also be used to create an automatic swell in volume. The RPx400 includes two different types of
Noise Gates: Silencer™, and Pluck. The Silencer™ operates as a standard Noise Gate. The Pluck Noise
Gate is designed to close after every note (depending on the Pluck Sensitivity). This allows automatic vol-
ume swells to occur on a note by note basis.

DIRECT - Cabinet Off
1X12 1 - 1x12 Mic 1
1X12 2 - 1x12 Mic 2
1X12 3 - 1x12 Mic 3
1X12 4 - 1x12 Mic 4

2X12o 1 - 2x12 Open Back Mic 1
2X12o 2 - 2x12 Open Back Mic 2
2X12o 3 - 2x12 Open Back Mic 3
2X12o 4 - 2x12 Open Back Mic 4

2X12c 1 - 2x12 Closed Back Mic 1
2X12c 2 - 2x12 Closed Back Mic 2
2X12c 3 - 2x12 Closed Back Mic 3
2X12c 4 - 2x12 Closed Back Mic 4

4X12V 1 - 4x12 Vintage Mic 1
4X12V 2 - 4x12 Vintage Mic 2
4X12V 3 - 4x12 Vintage Mic 3
4X12V 4 - 4x12 Vintage Mic 4

4X12B 1 - 4x12 British Mic 1
4X12B 2 - 4x12 British Mic 2
4X12B 3 - 4x12 British Mic 3
4X12B 4 - 4x12 British Mic 4

4X12G 1 - 4x12 Green Mic 1
4X12G 2 - 4x12 Green Mic 2
4X12G 3 - 4x12 Green Mic 3
4X12G 4 - 4x12 Green Mic 4
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На следующей Диаграмме показаны различия между позициями микрофона.

Эквалайзер
Эквализация – чрезвычайно полезная функция для выравнивания shape (формы) и тона 

гитарного сигнала. Функции Регуляторов на RPx400 идентичны регуляторам 
тона на усилителе. Все 3 параметра эквалайзера изменяются от -12 дБ до 
+12дБ.

EQ On/Off – Регулятор 1 включает (On) и выключает (OF) эквалайзер.
Bass – Регулятор 2 изменяет количество низких частот.
Mid Frequency – Регулятор 3 выбирает частоту, к которой будет применяться регулятор 

уровня средних частот. Доступны значения от 500 Гц (500Hz.) до 3000 Гц 
(3000Hz.).

Mid Level - Регулятор 4 изменяет количество средних частот.
Treble – Регулятор 5 изменяет количество высоких частот.

Шумоподавление
Функция Шумоподавления создана для предотвращения посторонних шумов во время, 

вашей игры. Также Шумоподавление можно использовать для создания 
автоматического затухания в звуке. RPx400 содержит два типа Шумоподавления: 
Silencer™ и Pluck™. Silencer™ является стандартным инструментом поглощения 
шума. Шумоподавление Pluck™ создано для затухания звука после каждой 
сыгранной ноты (зависит от выставленной чувствительности Pluck). Таким 
образом уровень громкости 

Включение/выключение шумоподавления – Регулятор 1 включает (On) и выключает (OF) 
функцию Шумоподавления.

Тип шумоподавления – Регулятор 2 позволяет выбрать тип шумоподавления между Silenc-
er™ (SILNCR) и Pluck (PLUCK).

Gate Attack – Регулятор 3 позволяет изменить длину временного отрезка, необходимого 
для срабатывания шумоподавления после превышения заданного порога. 
Доступны значения от 1 (резкое затухание) до 9 (автоматическое плавное 
затухание. При таком виде настройки звук будет повышаться постепенно).

Gate Threshold – Регулятор 4 устанавливает силу сигнала, по достижении которого 
шумоподавление срабатывает или перестает действовать. Параметр Gate 
Threshold изменяется от 1 (срабатывает от слабого сигнала) до 99 (необходим 
мощный сигнал для срабатывания).

Pluck Sensivity – Регулятор 5 устанавливает точку перезапуска поглощения звука. Эта 
функция доступна только если Pluck™ выбран в качестве типа Шумоподавления. 
Данный параметр изменяется от 1 (необходим мощный сигнал для перезапуска) 
до 99 (перезапускается происходит от слабых сигналов).



Chorus/Mod Effects
Набор Chorus/модуляционных эффектов в RPx400 представляет из себя 
многофункциональный модуль, позволяющий использовать такие эффекты как: Cho-
rus, Flanger, Triggered Flanger, Tremolo, Panner, Vibrato, Rotary Speaker, YaYa™, AutoYa™, 
Synth Talk™, Envelope Filter (auto wah), Detune, Pitch Shift и Whammy™. В режиме выбора 
Эффектов Регулятор 1 включает модуль Эффектов (EFFECT OF) и позволяет выбрать тип 
Модуляционного Эффекта. После выбора типа эффекта данного модуля, вы можете 
изменить индивидуальные параметры выбранного эффекта Регуляторами 2-5. Далее 
описаны характеристики Эффектов и их Параметров:

Chorus
Эффект chorus добавляет короткое эхо к сигналу. Обработанный сигнал modulated 
in and out of tune, а затем добавляется к оригинальному сигналу, создавая, таким 
образом, более плотный звук.
Параметр 1 – Регулятор 2 изменяет скорость модуляции. Доступны значения от 1 до 99.
Параметр 2 – Регулятор 3 изменяет интенсивность (глубину) модуляции. Доступны 
значения от 1 до 99.
Уровень модуляции (Mod Level) – Регулятор 5 изменяет уровень звука эффекта. 
Доступны значения от 1 до 99.
Регулятор 4 не несет никаких функций при выборе эффекта Chorus.

Flange
Его отличает более короткое время смещения копии сигнала, а также наличие 
регенерации (повторений) модулируемого делэя. В результате звук приобретает 
эффект плавного возвратно-поступательного движения.
Параметр 1 – Регулятор 2 изменяет скорость модуляции. Доступны значения от 1 до 99.
Параметр 2 – Регулятор 3 изменяет интенсивность (глубину) модуляции. Доступны 
значения от 1 до 99.
Параметр 3 – Регулятор 4 изменяет количество повторений, добавляемых к Flanger de-
lay. Доступны значения от 1 до 99.
Уровень модуляции (Mod Level) – Регулятор 5 контролирует уровень воздействия 
эффекта на выходной сигнал. Доступны значения от 0 (сигнал остается без изменений) 
до 99 (максимально обработанный).

Triggered Flanger
Flanger с триггером, в отличие от простого, позволяет выбрать начальную точку 
движения. В обычном Flanger осциллятор низких частот (LFO) постоянно изменяет 
частоту. Момент начала игры может приходится на верхнюю, нижнюю или любую 
другую точку цикла. При использовании Triggered Flanger, каждый раз, когда сигнал 
превышает Уровень чувствительности, Flanger включается на точке, заданной вами. 
Значение начального пункта изменяется Параметром LFO Start.
Параметр 1 – Регулятор 2 изменяет скорость модуляции. Доступны значения от 1 до 99.
Параметр 2 – Регулятор 3 изменяет мощность сигнала (чувствительность), после 
которого срабатывает flanger. Доступны значения от 1 (реагирует на мощный сигнал) 
до 99 (реагирует от слабого сигнала).
Параметр 3 – Регулятор 4 позволяет выбрать точку начала цикла (LFO Start). Доступны 
значения от 0 до 99.
Уровень модуляции (Mod Level) – Регулятор 5 контролирует уровень воздействия 
эффекта на выходной сигнал. Доступны значения от 0 (сигнал остается без изменений) 
до 99 (максимально обработанный).



Phaser
Фазер разделяет входящий сигнал, меняя его фазу. Копия сигнала, измененная по фазе, 

смешивается с оригиналом. В результате изменения фазы некоторые частоты 
сигнала исключаются, а к звуку добавляется легкий свист.

Параметр 1 – Регулятор 2 изменяет скорость модулируемой фазы. Доступны значения 
от 1 до 99.

Параметр 2 – Регулятор 3 изменяет интенсивность (глубину) модуляции. Доступны 
значения от 1 до 99.

Уровень модуляции (Mod Level) – Регулятор 5 контролирует уровень воздействия эффекта 
на выходной сигнал. Доступны значения от 0 (сигнал остается без изменений) 
до 99 (максимально обработанный).

Triggered Phaser
Phaser с триггером, в отличие от простого, позволяет выбрать начальную точку движения. 

В обычном Phaser осциллятор низких частот (LFO) постоянно меняет фазу 
сигнала. Момент начала игры может приходится на верхнюю, нижнюю или 
любую другую точку цикла. При использовании Triggered Phaser, каждый раз, 
когда сигнал превышает Уровень чувствительности, Phaser включается на 
точке, заданной вами. Значение начального пункта изменяется Параметром 
LFO Start.

Параметр 1 – Регулятор 2 изменяет скорость модулируемой фазы. Доступны значения 
от 1 до 99.

Параметр 2 – Регулятор 3 изменяет мощность сигнала (чувствительность), после которого 
срабатывает phaser. Доступны значения от 1 (реагирует на мощный сигнал) 
до 99 (реагирует от слабого сигнала).

Параметр 3 – Регулятор 4 позволяет выбрать точку начала цикла (LFO Start). Доступны 
значения от 0 до 99.

Уровень модуляции (Mod Level) – Регулятор 5 контролирует уровень воздействия эффекта 
на выходной сигнал. Доступны значения от 0 (сигнал остается без изменений) 
до 99 (максимально обработанный).

Tremolo
Эффект тремоло изменяет амплитуду сигнала.
Параметр 1 – Регулятор 2 изменяет скорость, на которой модулируется уровень звука. 

Доступны значения от 1 до 99.
Параметр 2 – Регулятор 3 изменяет интенсивность (глубину) модуляции уровня звука. 

Доступны значения от 0 до 99.
Регуляторы 4 и 5 не несут никаких функций при выборе эффекта Tremolo.



Panner
Эффект Автоматического Панорамирования изменяет панораму сигнала на опреде-
ленной скорости.
Параметр 1 – Регулятор 2 изменяет скорость перемещения сигнала из одного канала в 
другой. Доступны значения от 1 до 99.
Параметр 2 – Регулятор 3 изменяет интенсивность (глубину) смены каналов. Доступны 
значения от 0 до 99.
Регуляторы 4 и 5 не несут никаких функций при выборе эффекта Panner.

Vibrato
Эффект вибрато модулирует амплитуду тона входящего сигнала.
Параметр 1 – Регулятор 2 изменяет скорость модулирования высоты тона. Доступны зна-
чения от 1 до 99.
Параметр 2 – Регулятор 3 изменяет интенсивность (глубину) модулируемой высоты тона. 
Доступны значения от 1 до 99.
Регуляторы 4 и 5 не несут никаких функций при выборе эффекта Vibrato.

Rotary Speaker 
Rotary Speaker является эмуляцией устройства, состоящего из рупора и вуфера. Враще-
ние этих двух динамиков создает интересную комбинацию звука, перемещающегося 
из стороны в сторону с небольшим изменением высоты тона (в зависимости от прибли-
жения или удаления источника звука от слушателя).
Параметр 1 – Регулятор 2 изменяет скорость вращения динамиков. Доступны значения 
от 0 до 99.
Параметр 2 – Регулятор 3 изменяет интенсивность эффекта. Доступны значения от 0 до 99.
Параметр 3 – Регулятор 4 устанавливает эффект Доплера, возникающего из-за смены 
положений рупора и вуфера Доступны значения от 1 до 99.
Уровень модуляции (Mod Level) – Регулятор 5 контролирует уровень воздействия эффек-
та на выходной сигнал. Доступны значения от 0 (сигнал остается без изменений) до 99 
(максимально обработанный).

YaYa™

Эффект YaYa™ является эксклюзивным продуктом компании DigiTech. является уникаль-
ным вокодером, совмещая в себе особенности wah и flanger. В зависимости от движе-
ния Педали Экспрессии гитара как бы выговаривает «йа-йа». Чтобы эффект YaYa™ рабо-
тал, его необходимо подключить к Педали Экспрессии. Информацию о подключении 
Педали Экспрессии см. на стр. 18. 
Параметр 1 – Регулятор 2 включает Педаль Экспрессии.
Параметр 2 – Регулятор 3 изменяет интенсивность эффекта YaYa™. Доступны значения от 
1 до 99.
Параметр 3 – Регулятор 4 изменяет качество эффекта. Доступны значения от 1 до 99.
Уровень модуляции (Mod Level) – Регулятор 5 контролирует уровень воздействия эффек-
та на выходной сигнал. Доступны значения от 0 (сигнал остается без изменений) до 99 
(максимально обработанный).

AutoYa™

AutoYa™ также сочетает в себе свойства wah и flanger, придавая звуку схожесть с чело-
веческим голосом. AutoYa™ изменяет звук автоматически.
Параметр 1 – Регулятор 2 изменяет скорость модуляции. Доступны значения от 1 до 99.
Параметр 2 – Регулятор 3 изменяет интенсивность эффекта AutoYa™. Доступны значения 
от 1 до 99.
Параметр 3 – Регулятор 4 изменяет качество эффекта. Доступны значения от 1 до 99.
Уровень модуляции (Mod Level) – Регулятор 5 контролирует уровень воздействия эффек-
та на выходной сигнал. Доступны значения от 0 (сигнал остается без изменений) до 99 
(максимально обработанный).



Synth Talk™

Synth Talk™ – еще один эксклюзивный эффект от DigiTech. Он придает звуку гитары голо-
совой оттенок в зависимости от динамики игры.
Параметр 1 – Регулятор 2 изменяет атаку синтезированного голоса. Доступны значения 
от 1 до 99.
Параметр 2 – Регулятор 3 изменяет восстановление синтезированного голоса. Доступ-
ны значения от 1 до 99.
Параметр 3 – Регулятор 4 меняет характеристику синтетических голосов. Доступны зна-
чения от 1 до 99.
Уровень модуляции (Mod Level) – Регулятор 5 контролирует уровень чувствительности 
входящего сигнала, требуемого для запуска SynthTalk™. Доступны значения от 0 до 99.

Envelope Filter
Этот эффект представляет из себя автоматический Wah, срабатывающий в зависимос-
ти от силы удара по струнам.
Параметр 1 – Регулятор 2 изменяет уровень интенсивности Wah, после его включения. 
Доступны значения от 1 до 99.
Параметр 2 – Регулятор 3 изменяет уровень чувствительности, необходимый для сраба-
тывания эффекта.  Доступны значения от 1 до 99.
Уровень модуляции (Mod Level) – Регулятор 5 контролирует уровень воздействия эффек-
та на выходной сигнал. Доступны значения от 0 (сигнал остается без изменений) до 99 
(максимально обработанный).

Detune
Detuner дублирует входящий сигнал, а затем незначительно изменяет высоту его тона. 
На выход поступают оба сигнала, что создает впечатление синхронной игры сразу на 
двух инструментах.
Параметр 1 – Регулятор 2 изменяет соотношение высоты основного и дублируемого 
тона. Доступны значения от -18 до 18.
Уровень модуляции (Mod Level) – Регулятор 5 контролирует уровень громкости изменен-
ной ноты. Доступны значения от 0 до 99.
Регуляторы 4 и 5 не несут никаких функций при выборе эффекта Detuner.

Pitch Shift
Pitch Shift дублирует входящий сигнал, а затем изменяет высоту его тона на другую ноту. 
Измененная нота поступает на выход вместе с оригиналом, создавая эффект игры гар-
монии двумя гитарами одновременно.
Параметр 1 – Регулятор 2 изменяет интервал изменяемой высоты тона. Доступны значе-
ния от -12 (12 полутонов вниз) до 24 (24 полутона вверх).
Уровень модуляции (Mod Level) – Регулятор 5 контролирует уровень громкости изменен-
ной высоты тона. Доступны значения от 0 до 99.
Регуляторы 4 и 5 не несут никаких функций при выборе эффекта Pitch Shift.



Whammy™

С помощью Педали Экспрессии Whammy™ может изменять частоту входящего сигнала 
или добавлять к нему определенную гармонию. Высота ноты изменяется в зависимости 
от движения педали. В цепочке эффектов Whammy™ автоматически становится перед 
Моделированием Усилителя (см. диаграмму в начале раздела «Эффекты»). Чтобы эф-
фект Whammy™ работал, его необходимо подключить к Педали Экспрессии. Информа-
цию о подключении Педали Экспрессии см. на стр. 18. 
Параметр 1 – Регулятор 1 определяет интервал и направление смены тона. Имеются 
следующие варианты:

Whammy (без необработанного сигнала) Гармонические сдвиги (с добавление 
необработанного сигнала)

1OCTUP (1 октава вверх) M3>MA3 (от минорной до мажорной терции)

2OCTUP (2 октавы вверх) 2NDMA3 (от секунды вверх до мажорной терции 
вверх)

2NDDWN (секунда вниз) 3RD4TH (от кварты вверх до квинты вверх)

REV2ND (секунда вниз reversed pedal action) 5THOCT (от квинты вверх до октавы вверх)

4THDWN (кварта вниз) HOCTUP (1 октава вверх)

1OCTDN (1 октава вниз) HOCTDN (1 октава вниз)

2OCTDN (2 октавы вниз)

DIVBOM (Dive Bomb)

Уровень модуляции (Mod Level) – Регулятор 5 контролирует уровень громкости эффекта. 
Доступны значения от 0 до 99.
Регуляторы 4 и 5 не несут никаких функций при выборе эффекта Whammy™.

Delay
Delay записывает часть входящего сигнала, а затем воспроизводит его с небольшой за-
держкой. Звук может повторяться один или несколько раз, а также бесконечное коли-
чество (вы можете сыграть фрагмент, который будет повторяться делеем, а затем играть 
поверх него другие свои партии)
Включение/выключение delay – Регулятор 1 включает (On) и выключает (OF) delay.
Тип delay – Регулятор 2 позволяет выбрать один из 3х типов delay: DIGITAL (цифровой delay), 
ANALOG (аналоговый delay), P PONG (Ping-pong delay).
Время задержки – Регулятор 3 изменяет время задержки delay. Доступны значения от 
10MS до 990MS (от 10 до 990 миллисекунд с шагом в 10 миллисекунд) и  10SEC до 20SEC (от 1 
до 2 секунд, с шагом в 100 миллисекунд).
Количество повторений – Регулятор 3 изменяет количество повторений обработанного 
сигнала. Доступны значения от 1 до 99, а также RHOLD (бесконечное повторение).

Reverb
Реверберация придает звуку ощущение материальности и может воспроизводить акус-
тику различных видов помещения. Можно воспроизвести акустику небольшой комнаты 
или, например пустого стадиона.
Тип реверберации – Регулятор 1 позволяет выбрать тип акустического помещения. RPx400 
предоставляет 10 типов различных видов реверберации.

REV OF – реверберация 
отключена

PLATE – быстрое отражение GARAGE – гараж

STUDIO – студия HALL – зал ARENA – стадион
ROOM – комната с 
деревянными стенами

AMPTHE – амфитеатр

CLUB – клуб CHURCH – церковь SPRING – Church



Педаль Экспрессии
Педаль Экспрессии может быть задействована для управлением некоторыми 
параметрами эффектов RPx400 (уровень звука, YaYa™, Whammy™ и многими другими). 
Для этого необходимо закрепить за педалью тот или иной параметр. После закрепления 
параметра можно изменить уровни его максимального и минимального значения. Для 
этого необходимо следующее:
1. Нажимайте кнопку Select до входа в ряд Экспрессии на матрице (диод загорается 
над меню Экспрессии).
2. Поворачивайте Регулятор 1 до появления на дисплее PEDAL.
3. Поворачивайте Регулятор 2 до появления на дисплее необходимого вам Параметра.
4. Поворачивайте Регулятор 3 для выбора минимального значения установленного 
параметра при поднятой педали (если параметром является уровень громкости – 
данная функция не работает).
5. Поворачивайте Регулятор 4 для выбора максимального значения установленного 
параметра при опущенной педали (если параметром является уровень громкости 
– данная функция не работает).
6. Сохраните параметры назначенной функции в пресет. Подробную информацию по 
сохранению изменений см. на стр. 9.

Педалью Экспрессии можно контролировать следующие параметры:
A GAIN – Педаль Экспрессии изменяет уровень усиления или уровень дисторшна для 
выбранного Типа Усилителя.
AMPLVL – Педаль Экспрессии изменяет уровень громкости выбранного Типа Усилителя.

Параметры Модуляционных Эффектов
Действующий эффект	 Доступные параметры
Chorus	 SPEED (скорость),	 DEPTH (интенсивность)
Flanger	 SPEED (скорость),	 DEPTH (интенсивность),	 REGEN (регенерация сигнала)
Triggered Flanger	 SPEED (скорость),	 SENSTV(чувствительность),	 LFOSTR (запуск LFO)
Phaser	 SPEED (скорость),	 DEPTH (интенсивность),	 REGEN (регенерация сигнала) 
Triggered Phaser	 SPEED (скорость),	 SENSTV (чувствительность),	 LFOSTR (запуск LFO)
Tremolo	 SPEED (скорость),	 DEPTH (интенсивность)
Vibrato	 SPEED (скорость),	 DEPTH (интенсивность)
Rotary Speaker	 SPEED (скорость),	 DEPTH (интенсивность)	 DOPLER (Doppler)
Panner	 SPEED (скорость),	 DEPTH (интенсивность)
YaYa™	 PEDAL (педаль),	 DEPTH (интенсивность),	 RANGE (диапазон)
AutoYa™	 SPEED (скорость),	 DEPTH (интенсивность),	 RANGE (диапазон)
SynthTalk™	 ATTACK (атака),	 RELEAS (восстановление),	 VOX (?),	 SENSTV (чувствительность)
Envelope Filter	 AMOUNT (количество),	 SENSTV (чувствительность)
Detune	 AMOUNT (количество)
Pitch Shift	 AMOUNT(количество)
Whammy™	 AMOUNT (количество)

PreDelay – Регулятор 2 изменяет промежуток времени, за который исходный звук дости-
гает отражающей поверхности эмулируемого помещения. Доступны значения 
от 0 до 15

Decay – Регулятор 3 изменяет временной отрезок, во время которого слышна ревербе-
рация. Доступны значения от 1 до 99.

Damping – Регулятор 4 изменяет уровень звука, поглощаемого поверхностями эмулиру-
емого помещения. Доступны значения от 0 до 99.

Уровень реверберации – Регулятор 5 изменяет уровень громкости реверберации. До-
ступны значения от 0 до 99.



YAYA (YaYa™)	 Педаль Экспрессии отвечает за уровень эффекта YaYa™.
WHAMMY (Whammy™)	 Педаль Экспрессии отвечает за уровень эффекта Whammy™.
EFFLVL	 Педаль Экспрессии регулирует громкость выбранного
	 типа модуляционного	эффекта.
FBACK	 Педаль Экспрессии регулирует количество повторений delay.
DLYLVL	 Педаль Экспрессии регулирует громкость выбранного типа delay.
DECAY	 Педаль Экспрессии регулирует время угасания реверберации.
REVLVL	 Педаль Экспрессии регулирует уровень громкости реверберации.
VOLPRE	 Педаль Экспрессии регулирует уровень звука после Моделирования
	 Усилителя, но до обработки эффектами.
VOLPST	 Педаль Экспрессии регулирует уровень звука на выходе
	 цепочки эффектов.

V-Switch
Педаль Экспрессии RPx400 содержит уникальный переключатель V-Switch. Он позво-
ляет немедленно переключаться между назначенными на педаль параметрами. При 
сильном нажатии на переднюю часть Педали Экспрессии, V-Switch переключает ее 
с текущего параметра на Wah. Чувствительность срабатывания V-Switch может быть 
изменена исходя из ваших предпочтений (или в зависимости от веса ноги). Подробнее 
о настройке чувствительности V-Switch см. на стр. 36.

LFO (осциллятор низких частот)
RPx400 содержит в себе два осциллятора низких частот (LFP TR и LFO SQ). Их можно при-
крепить к любому из параметров, связанных с Педалью Экспрессии. Осциллятор низ-
ких частот автоматически изменит значение прикрепленного параметра. Минималь-
ное и максимальное значения действия LFO так же могут быть прикреплены. Например, 
если Уровень Усилителя (Amp Gain) прикреплен к LFO TR, с минимальным значением 1, 
а максимальным – 99, RPx400 автоматически переключится с чистого звука на дистор-
шн. Скорость LFO также можно изменить. В предыдущем примере скорость LFO будет 
определять длину временного отрезка, во время которого совершится переход с чис-
того звука на дисторшн. LFO TR использует волны треугольной формы, а LFO SQ – квад-
ратные волны. Для прикрепления LFO к параметру необходимо следующее:

1. Нажимайте кнопку Select до входа в ряд Экспрессии на матрице (диод загорается 
над меню Экспрессии).

2. Поворачивайте Регулятор 1 для выбора осциллятора LFO TR или LFO SQ.

3. Поворачивайте Регулятор 2 до появления на дисплее необходимого вам параметра.
4. Поворачивайте Регулятор 3 для выбора минимального значения выбранного пара-

метра, которое достигается в нижней точке LFO (педаль находится в крайнем ниж-
нем положении). Если параметром является уровень громкости – данная функция не 
работает.

5. Поворачивайте Регулятор 4 для выбора максимального значения выбранного пара-
метра, которое достигается в верхней точке LFO (педаль находится в крайнем верх-
нем положении). Если параметром является уровень громкости – данная функция не 
работает.

6. Поворачивайте Регулятор 5 для выбора скорости, с которой LFO будет изменяться от 
минимального до максимального значения

7. Сохраните параметры назначенной функции в пресет. Подробную информацию по 
сохранению изменений см. на стр. 9.



Настройки RPx400
Введение
RPx400 оборудован четырьмя входами и четырьмя выходами, которые могут быть 
сконфигурированы различными способами, как для выступления, так и для записи. 
Настройки этих конфигураций изменяются Регуляторами через меню Drums/Setup в 
матрице редактирования. Доступны такие возможности как: выбор входа (микрофонный 
или линейный) для последующей обработки звука эффектами процессора; возможность 
установки Speaker Compensation на любой из выходов; возможность выбора направления 
для гитарной обработки, микрофонного и линейного выходов. Регуляторы USB 1-2 Source 
и USB 3-4 Source используются для конфигурации направления сигналов со всех входных 
гнезд, гитарной обработки и драм-машины через USB в компьютер для записи.

Микрофонные/Линейные установки
Микрофонные и Линейные установки для соответствующих входных гнезд созданы 
прежде всего для выступления. RPx400 действует как микшер для микрофона и 
линейных источников. Это устраняет необходимость в микшерском оборудовании, 
когда RPx400 подключен напрямую к высоко-мощной акустической системе. В таком 
случае входные сигналы могут быть направлены через обработку эффектами RPx400, 
либо минуя ее, а затем посланы непосредственно в выходы 1/4” либо XLR-выходы.

Оба входа имеют 4 параметра настроек, которые отображены на матрице эффектов 
в разделе Drums/Setup. Параметры изменяются с помощью регуляторов Mic и Line. 
Доступны следующие конфигурации:

MICOFF/LINOFF – Микрофонный и Линейный входы отключены.
MICDRY/LINDRY – Входные сигналы направлены напрямую в выходы RPx400, не подвергаясь 

обработке эффектами.
MICRVB/LINRVB – Входные сигналы проходят через обработку Delay и Reverb текущего пресета.
MICFX/LINEFX – Входные сигналы проходят через весь набор эффектов текущего пресета.

RPx400 Setups
Setups Introduction
The RPx400 is equipped with four inputs and four outputs that can be configured several different ways for
both live and recording applications. These configurations are selected in the DRUMS/SETUP row of the
editing matrix using the five editing knobs. Settings include whether the Mic or Line inputs are routed
through the RPx400’s effects processing, which outputs have Speaker Compensation enabled, and which pair
of outputs mic, line, and guitar processing are routed to. The USB 1-2 Source and USB 3-4 Source knobs
are used for configuring how all inputs, guitar processing, and drum machine are routed via USB to the com-
puter for recording applications.

Mic / Line Setups
The Mic and Line Setups are configurations for the mic and line inputs designed primarily for live per-
formance applications. The RPx400 acts as a mixing device for mic and line sources, and can eliminate the
need for a mixer when the RPx400’s outputs are to be plugged directly into a full-range powered speaker
system. When enabled, these inputs can be routed around or through the RPx400’s effects processing
and then mixed directly into the RPx400’s 1/4” and XLR outputs.

Both Mic and Line inputs have four settings that can be independently selected using the Mic and Line
knobs in the DRUMS/SETUP row of the effect matrix. The configurations are as follows:

MICOFF / LINOFF - Mic and Line inputs are disabled.
MICDRY / LINDRY - Inputs routed directly to RPx400’s outputs, bypassing all effects processing.
MICRVB / LINRVB - Inputs routed through delay and reverb effects of the current preset.
MICFX / LINEFX - Inputs routed through all effects of current preset.
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SC ALL – Стерео guitar processing, микрофон и линейные источники направлены в обе 
выходные пары. Speaker Compensation действует на 1/4” и XLR-выходы.

Режимы SPLIT1 и SPLIT2 предназначены для изоляции гитарной обработки от сигналов 
микрофона, линейных источников, драм-машины и аккомпанемента во время 
выступления. В режиме SPLIT1 гитарный сигнал поступает на 1/4” выходы, а сигналы 
микрофона, линейных источников, драм-машины и аккомпанементс компьютера 
поступают на XLR-выходы. Режим SPLIT2 отличается от SPLIT1 тем, что гитарный сигнал со 
Speaker Compensation также направлен на XLR-выходы.

Speaker Compensation and Output Modes
The RPx400 features both 1/4” and XLR outputs on the rear panel. These jacks let you simultaneously
connect the RPx400 to an amplifier/speaker system on stage via the 1/4” outputs and connect directly to
your PA system via the XLR outputs. The RPx400 incorporates Speaker Compensation filtering that can
be turned on or off independently for each output pair depending on your application needs.
The six output modes for the RPx400 are as follows:

SCOFF - All input sources (guitar, mic, line, drums, and recorder playback) are routed to both output
pairs. Speaker Compensation is turned off.

SCXLR - All input sources are routed to both output pairs. Speaker Compensation is turned on in XLR
outputs only.

SC 1/4 - All input sources are routed to both output pairs. Speaker Compensation is turned on in 1/4”
outputs only.

SC ALL - Stereo guitar processing, mic, and line sources out both output pairs. Speaker Compensation is
turned on in both 1/4” and XLR outputs.
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Speaker Compensation и режимы выходного сигнала.
RPx400 оборудован выходными гнездами 1/4” и XLR на задней панели. Это дает 
возможность одновременно подключать RPx400 к усилителю/акустической системе 
на сцене (через 1/4” выход) и к PA-системе (через выход XLR). RPx400 имеет функцию 
Speaker Compensation, которую можно независимо направить на любую из выходных 
пар, исходя из ваших потребностей. Далее следует описание шести возможных видов 
направления выходного сигнала RPx400.

SCOFF – Все входные сигналы (гитара, микрофон, линейный источник, барабанный 
паттерн и аккомпанемент) направлены в обе выходные пары. Speaker Compen-
sation отключен.

SCXLR - Все входные сигналы направлены в обе выходные пары. Speaker Compensation 
действует только на XLR-выходы.

SC 1/4 - Все входные сигналы направлены в обе выходные пары. Speaker Compensation 
действует только на 1/4” выходы.

Speaker Compensation and Output Modes
The RPx400 features both 1/4” and XLR outputs on the rear panel. These jacks let you simultaneously
connect the RPx400 to an amplifier/speaker system on stage via the 1/4” outputs and connect directly to
your PA system via the XLR outputs. The RPx400 incorporates Speaker Compensation filtering that can
be turned on or off independently for each output pair depending on your application needs.
The six output modes for the RPx400 are as follows:

SCOFF - All input sources (guitar, mic, line, drums, and recorder playback) are routed to both output
pairs. Speaker Compensation is turned off.

SCXLR - All input sources are routed to both output pairs. Speaker Compensation is turned on in XLR
outputs only.

SC 1/4 - All input sources are routed to both output pairs. Speaker Compensation is turned on in 1/4”
outputs only.

SC ALL - Stereo guitar processing, mic, and line sources out both output pairs. Speaker Compensation is
turned on in both 1/4” and XLR outputs.
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Speaker Compensation and Output Modes
The RPx400 features both 1/4” and XLR outputs on the rear panel. These jacks let you simultaneously
connect the RPx400 to an amplifier/speaker system on stage via the 1/4” outputs and connect directly to
your PA system via the XLR outputs. The RPx400 incorporates Speaker Compensation filtering that can
be turned on or off independently for each output pair depending on your application needs.
The six output modes for the RPx400 are as follows:

SCOFF - All input sources (guitar, mic, line, drums, and recorder playback) are routed to both output
pairs. Speaker Compensation is turned off.

SCXLR - All input sources are routed to both output pairs. Speaker Compensation is turned on in XLR
outputs only.

SC 1/4 - All input sources are routed to both output pairs. Speaker Compensation is turned on in 1/4”
outputs only.

SC ALL - Stereo guitar processing, mic, and line sources out both output pairs. Speaker Compensation is
turned on in both 1/4” and XLR outputs.
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SPLIT2 – Стереосигнал гитарной обработки поступает на 1/4”” выходы без Speaker 
Compensation. Стереосигнал гитарной обработки, аккомпанемент с 
компьютера, микрофон и линейные источники поступают на XLR-выходы без 
Speaker Compensation.

The SPLIT1 and SPLIT2 Output Modes are designed for when you want to keep the guitar processing
isolated from mic, line, drums, and audio playback during live performance. The SPLIT1 Output mode
routes guitar signal to the 1/4” outputs while the mic, line input sources, drums, and audio playback from
the computer are routed out the XLR outputs. SPLIT2 is the same as SPLIT1 but the guitar signal with
Speaker Compensation is also routed out the XLR outputs.

SPLIT1 - Stereo guitar processing is routed to the 1/4” outputs without Speaker Compensation. Audio
playback from the computer, mic, and line sources are routed to the XLR outputs.

SPLIT2 - Stereo guitar processing is routed to the 1/4” outputs without Speaker Compensation. Stereo
guitar processing, audio playback from the computer, mic, and line sources are routed to the
XLR outputs with Speaker Compensation.

NOTE: Speaker Compensation may affect Mic and Line signals depending on which Output
Mode is selected.
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ПРИМЕЧАНИЕ: Включенный Speaker Compensation может вызвать искажение микрофонного и 
линейного сигналов, в зависимости от выбранного режима выхода.

SPLIT1 – Стереосигнал гитарной обработки поступает на 1/4” выходы без Speaker 
Compensation. Аккомпанемент с компьютера, микрофон и линейные источники 
поступают на XLR-выходы.

The SPLIT1 and SPLIT2 Output Modes are designed for when you want to keep the guitar processing
isolated from mic, line, drums, and audio playback during live performance. The SPLIT1 Output mode
routes guitar signal to the 1/4” outputs while the mic, line input sources, drums, and audio playback from
the computer are routed out the XLR outputs. SPLIT2 is the same as SPLIT1 but the guitar signal with
Speaker Compensation is also routed out the XLR outputs.

SPLIT1 - Stereo guitar processing is routed to the 1/4” outputs without Speaker Compensation. Audio
playback from the computer, mic, and line sources are routed to the XLR outputs.

SPLIT2 - Stereo guitar processing is routed to the 1/4” outputs without Speaker Compensation. Stereo
guitar processing, audio playback from the computer, mic, and line sources are routed to the
XLR outputs with Speaker Compensation.

NOTE: Speaker Compensation may affect Mic and Line signals depending on which Output
Mode is selected.
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RPx400 и функции записи
Введение
Наличие USB-порта RPx400 позволяет одновременно записывать 4 аудио-потока 
в компьютер и 2 дорожки сопровождения из компьютера. Никогда еще процесс 
записи не был таким простым, благодаря записывающему интерфейсу hands-free, 
предоставленным DigiTech и Pro Tracks software. Напольные переключатели RPx400 и 
программное обеспечение Pro Tracks работают синхронно. Это позволяет записывать 
воспроизводить и удалять звуковые дорожки на ходу, даже не убирая рук с гитары. Для 
удовлетворения ваших потребностей в процессе записи доступны многочисленные 
конфигурации настроек записи. Данные конфигурации находятся в меню Drums/Setup 
матрицы эффектов RPx400.

Перед началом записи необходимо установить прилагаемые USB-драйверы и 
программное обеспечение Pro Tracks на компьютер, совместимый с операционной 
системой Windows. USB-драйверы находятся на диске X-Edit Software, входящем в 
комплектацию RPx400. CD с программным обеспечением Pro Tracks находится в Pro 
Tracks box. Пожалуйста, ознакомьтесь с документацией Pro Tracks, чтобы убедиться в 
том, что конфигурация вашего компьютера соответствует необходимым требованиям 
для проведения инсталляции. После установки и необходимой настройки, функциями 
записи Pro Tracks можно управлять посредством RPx400.

Установка USB-драйверов RPx400
Перед началом использования редактора X-Edit и программного обеспечения Pro 
Tracks, необходимо установить USB-драйверы RPx400. драйверы находятся на диске X-
Edit Software, входящем в комплектацию процессора.

Пользователям Windows XP
1.	 Включите компьютер
2.	 Поместите диск X-Edit в CD-привод вашего компьютера. Меню инсталляции 
должно появиться автоматически (если программа автоматической инсталляции не 
запускается, зайдите в Start>Run, нажмите кнопку Browse, а затем найдите на диске 
X-Edit файл instmenu.exe и вызовите его двойным нажатием).
3.	 В первую очередь нужно установить USB-драйверы для возможности использования 
USB-соединения с программами X-Edit и Pro Tracks. При обновлении драйверов 
RPx400 следует проделать то же самое. Подключите RPx400 к компьютеру с помощью 
прилагаемого USB-кабеля. После этого, в панели задач на экране появятся уведомления 
о том, что компьютер обнаружил несколько USB-устройств (4 USB-устройства RPx400, 2 
MIDI-устройства  и 2 аудио-устройства).
4.	 Выберите из появившегося меню пункт USB Audio MIDI Drivers. Появится окно RPx400 
USB Driver Installer.

ПРИМЕЧАНИЕ: Если во время установки USB-соединение не установлено, появится напоминание о 
необходимости подключения процессора. В этом случае прервите установку, подключите RPx400 к 
компьютеру через USB-вход, а затем запустите инсталляционную программу.

5.	 Когда RPx400 подключен должным образом, на экране появится окно Hardware In-
stallation. На каждом из четырех появляющихся после этого окнах нажмите на кнопку 
Continue Anyway.
6.	 Нажмите кнопку Finish. Установка USB-драйверов завершена. Теперь вы можете 
использовать RPx400 для записи (с помощью программы Pro Tracks).



Пользователям Windows 2000
1.	 Включите компьютер
2.	 Поместите диск X-Edit в CD-привод вашего компьютера. Меню инсталляции должно появиться 

автоматически (если программа автоматической инсталляции не запускается, войдите 
в Start>Run, нажмите кнопку Browse, а затем найдите на диске X-Edit файл instmenu.exe и 
вызовите его двойным нажатием).

3.	 В первую очередь нужно установить USB-драйверы для возможности использования USB-
соединения с программами X-Edit и Pro Tracks. Убедитесь в  том, что RPx400 НЕ ПОДКЛЮЧЕН к 
компьютеру.

4.	 Выберите из появившегося меню пункт USB Audio MIDI Drivers. Появится окно RPx400 USB Driver 
Installer. Нажмите кнопку Next.

5.	 После появления окна The Digital Signature Not Found, нажмите кнопку Yes.
6.	 После повторного появления окна The Digital Signature Not Found, снова нажмите кнопку Yes.
7.	 Затем появится окно RPx400 USB Driver Installer. Нажмите кнопку Finish.
8.	 Подключите RPx400 в USB-порт компьютера. После этого, в панели задач на экране появятся 

уведомления о том, что компьютер обнаружил несколько USB-устройств (4 USB-привода 
RPx400, 2 MIDI-привода и 2 аудиопривода). Далее необходимо сделать следующее:

9.	 После подключения RPx400 появится окно The Digital Signature Not Found. Нажмите кнопку Yes.
10.	 После появления окна Found New Hardware Wizard, нажмите кнопку Finish.
11.	 После появления окна System Settings Change, нажмите кнопку No.
12.	 После повторного появления окна The Digital Signature Not Found, нажмите кнопку Yes.
13.	 После повторного появления окна Found New Hardware Wizard, нажмите кнопку Finish.
14.	 После повторного появления окна System Settings Change, нажмите кнопку No.
15.	 После повторного появления окна The Digital Signature Not Found, нажмите кнопку Yes.
16.	 После повторного появления окна Found New Hardware Wizard, нажмите кнопку Finish.
17.	 После повторного появления окна System Settings Change, нажмите кнопку No.
18.	 После повторного появления окна Found New Hardware Wizard, нажмите кнопку Finish.
19.	 После повторного появления окна System Settings Change, нажмите кнопку Yes. Затем ваш 

компьютер автоматически перезагрузится.

Теперь вы можете использовать RPx400 для записи (с помощью программы Pro Tracks). 
Ознакомиться с возможностями функции записи можно в разделе Использование Pro 
Tracks.

Установка редактора X-Edit.
После установки USB-драйверов необходимо установить программу редактирования X-Edit. 
1.	 Возвратитесь в меню инсталляции (после п.2 Установки USB-драйверов) и выберите DigiTech 

X-Edit.
2.	 Программа инсталляции проверит ваш компьютер на наличие Microsoft .NET Framework. Если 

таковая не обнаружится – запустится установка .NET. Следуйте появляющимся в процессе 
установки инструкциям.

3.	 После завершения установки .NET появится окно Welcome to the Installation Wizard for Digi-
Tech X-Edit 1.0.

4.	 Заполните требуемую информацию пользователя. Чтобы с X-Edit могли работать все 
пользователи компьютера, выберите Anyone who uses this computer. Если вы хотите быть 
единственным пользователем программы X-Edit – выберите Only for me. Нажмите кнопку Next.

5.	 На следующем экране нажмите кнопку Install.
6.	 После завершения инсталляции нажмите кнопку Finish.

Теперь вы можете использовать редактор X-Edit при работе с RPx400.



Подключение RPx400 к компьютеру
В комплектацию RPx400 входит USB-кабель, который должен быть подключен к 
компьютеру для записи или для работы с редактором X-Edit. Рекомендуется 
использовать только прилагаемый USB-кабель так как он был создан и протестирован 
в соответствии со спецификой применения. Для подключения RPx400 к компьютеру 
необходимо:
1.	 Отключить RPx400 от сети питания.
2.	 Вставить меньший конец USB-кабеля в джековое USB-гнездо на задней панели RPx400.
3.	 Вставить большой плоский конец USB-кабеля в свободный USB-порт вашего компьютера.
4.	 Включить RPx400 в сеть.

Установки RPx400 при записи
Наличие нескольких конфигураций направления входных/выходных сигналов 
открывает множество вариантов записи. Например можно одновременно записать 
обработанный и необработанный звук гитары, вокал, сигнал с линейных источников 
или любую другую комбинацию. Также можно повторно пропустить через RPx400 
записнную гитарную дорожку с необработанным звуком для ее обработки. В 
компьютер могут одновременно посылаться до 4х звуковых каналов. Варианты 
направления сигналов контролируются Регуляторами в меню Setup матрицы RPx400. 
Каждый USB-источник передает парные сигналы в компьютер. Далее описаны 
возможные варианты направления сигналов

USB 1-2 Source
STEREO – Все входные источники, обработанные эффектами RPx400 направляются на выходы USB 

1 и 2. 
MONO – Все входные источники, обработанные эффектами RPx400, суммируются в моно-сигнал и 

направляются на выходы USB 1. На выход USB 2 сигнал не поступает.
SUM+DG – Все входные источники, обработанные эффектами RPx400, суммируются в моно-сигнал и 

направляются на выходы USB 1. Не   обработанный гитарный сигнал поступает на USB 2.
SUMMIC – Все входные источники, обработанные эффектами суммируются в моно-сигнал и 

направляются на выходы USB 1. Необработанный микрофонный сигнал поступает на USB 2.
DGTR+M – Необработанный гитарный сигнал поступает на USB 1. Необработанный микрофонный 

сигнал поступает на USB 2.
DRYLIN – Необработанный линейный сигнал левого канала поступает на USB 1. Необработанный 

линейный сигнал правого канала поступает на USB 2.
DRYGTR – Необработанный гитарный сигнал поступает на USB 1. На USB 2 сигнал не поступает.
DRYMIC – Необработанный микрофонный сигнал поступает на USB 1. На USB 2 сигнал не 

поступает.
DRUMS – Воспроизведение барабанного паттерна поступает на USB 1. На USB 2 сигнал не 

поступает.
REAMP – Воспроизведение из Pro Tracks, обработанное эффектами RPx400, поступает на USB 1 

и USB 2. Подробную информацию о данной опции см. в разделе Повторное усиление 
записанного гитарного сигналана стр. 32.

USBOFF – Выходы USB 3 и USB 4 отключены
DGTR+M – Необработанный гитарный сигнал поступает на USB 3. Необработанный микрофонный 

сигнал поступает на USB 4.
DRYLIN – Необработанный линейный сигнал левого канала поступает на USB 3. Необработанный 

линейный сигнал правого канала поступает на USB 4.
DRYGTR – Необработанный гитарный сигнал поступает на USB 3. На USB 4 сигнал не поступает.
DRYMIC – Необработанный микрофонный сигнал поступает на USB 3. На USB 4 сигнал не 

поступает.



Направление микрофонного сигнала
Сигнал микрофона может быть пропущен через RPx400 различными способами. 
В режиме MICOFF сигнал микрофона не слышен, однако его можно записывать. В 
режиме MICDRY сигнал поступает на выходы, минуя обработку эффектами. MICRVB 
пропускает микрофонный сигнал через модули Delay и Reverb RPx400. В режиме MICFX 
сигнал может обрабатываться всеми эффектами процессора.

DRUMS – Воспроизведение барабанного паттерна поступает на USB 3. На USB 4 сигнал не 
поступает.

На следующей диаграмме показана последовательность направления сигналов 
через обработку RPx400 и поступления их на выходы.

Направление гитарного сигнала
Гитарный сигнал поступает на парные выходные гнезда через обработку RPx400. 
Сигнал, посланный на USB, может быть изолирован на входе (USB Send Path A) 
или после обработки рядом эффектов (USB Send Path C). В последствие, сигнал, 
записанный на USB Send Path A, можно пропустить через RPx400 для повторного 
усиления. Подробную информацию о данной опции см. в разделе Повторное 
усиление записанного гитарного сигнала на стр. 32.

Guitar Signal Routing
The guitar signal is routed from the input through the RPx400s effects processing and then to the pairs of
outputs. The signal sent up USB can be tapped off either at the input (USB Send Path A), or at the end
of the effects chain (USB Send Path C). Signals recorded from USB Send Path A can be played back
later through the RPx400 for re-amping. See Re-Amping a Guitar Track on page 32 for more information
on how this feature works.

Guitar USB Source Mapping
The guitar signal has two paths in which it can travel up the USB port to the computer. Path A taps the
guitar signal off right at the input and sends unprocessed signal up to the USB port. Path C taps the gui-
tar signal at the output of the RPx400 and can include any effects processing that may be used. Below is
a matrix to show where the signal is tapped based on how the Mic, USB 1-2 Source, and USB 3-4
Source settings are configured.

Mic Signal Routing
The mic signal can be routed in different ways through the RPx400. micoff disables the mic input from
being heard but dry mic signal can still be recorded. micdry routes the mic signal around the RPx400’s
effects processing and mixes it in at the outputs. micrvb routes the mic signal only through the RPx400
Delay and Reverb modules. micfx routes the mic signal through all of the RPx400’s effects.
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Guitar USB Source Mapping
Гитарный сигнал поступает в USB-порт компьютера по двум направлениям. На Пути A 
гитарный сигнал изолируется непосредственно на входе, после чего направляется 
на USB-порт без обработки. Путь С разделяет сигнал уже на выходе из RPx400, что 
позволяет добавлять к звуку любой набор эффектов. На схеме ниже показано место 
изоляции сигнала в зависимости от используемой конфигурации настроек Mic, USB 1-2 
Source и USB 3-4 Source.

Guitar Signal Routing
The guitar signal is routed from the input through the RPx400s effects processing and then to the pairs of
outputs. The signal sent up USB can be tapped off either at the input (USB Send Path A), or at the end
of the effects chain (USB Send Path C). Signals recorded from USB Send Path A can be played back
later through the RPx400 for re-amping. See Re-Amping a Guitar Track on page 32 for more information
on how this feature works.

Guitar USB Source Mapping
The guitar signal has two paths in which it can travel up the USB port to the computer. Path A taps the
guitar signal off right at the input and sends unprocessed signal up to the USB port. Path C taps the gui-
tar signal at the output of the RPx400 and can include any effects processing that may be used. Below is
a matrix to show where the signal is tapped based on how the Mic, USB 1-2 Source, and USB 3-4
Source settings are configured.

Mic Signal Routing
The mic signal can be routed in different ways through the RPx400. micoff disables the mic input from
being heard but dry mic signal can still be recorded. micdry routes the mic signal around the RPx400’s
effects processing and mixes it in at the outputs. micrvb routes the mic signal only through the RPx400
Delay and Reverb modules. micfx routes the mic signal through all of the RPx400’s effects.
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Guitar Signal Routing
The guitar signal is routed from the input through the RPx400s effects processing and then to the pairs of
outputs. The signal sent up USB can be tapped off either at the input (USB Send Path A), or at the end
of the effects chain (USB Send Path C). Signals recorded from USB Send Path A can be played back
later through the RPx400 for re-amping. See Re-Amping a Guitar Track on page 32 for more information
on how this feature works.

Guitar USB Source Mapping
The guitar signal has two paths in which it can travel up the USB port to the computer. Path A taps the
guitar signal off right at the input and sends unprocessed signal up to the USB port. Path C taps the gui-
tar signal at the output of the RPx400 and can include any effects processing that may be used. Below is
a matrix to show where the signal is tapped based on how the Mic, USB 1-2 Source, and USB 3-4
Source settings are configured.

Mic Signal Routing
The mic signal can be routed in different ways through the RPx400. micoff disables the mic input from
being heard but dry mic signal can still be recorded. micdry routes the mic signal around the RPx400’s
effects processing and mixes it in at the outputs. micrvb routes the mic signal only through the RPx400
Delay and Reverb modules. micfx routes the mic signal through all of the RPx400’s effects.
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Line USB Source Mapping
Как видно из предыдущей диаграммы, линейный сигнал поступает в USB-порт 
компьютера по двум направлениям. На Пути A линейный сигнал изолируется 
непосредственно на линейном входе, после чего направляется на USB-порт без 
обработки. Путь С разделяет сигнал уже на выходе из RPx400, что позволяет добавлять 
к звуку любой набор эффектов. На схеме ниже показано место изоляции сигнала в 
зависимости от используемой конфигурации настроек Line, USB 1-2 Source и USB 3-4 
Source.

Mic USB Source Mapping
The mic signal, as can be seen in the previous Mic Signal Routing diagram, has two paths in which it can
travel up the USB port to the computer. Path E taps the mic signal off right at the mic input and sends
unprocessed signal up to the USB port. Path C taps the signal at the output of the RPx400 and can
include any effects processing that may be used. Below is a matrix to show where the signal is tapped
based on how the Mic, USB 1-2 Source, and USB 3-4 Source settings are configured.

Line Signal Routing
The line signals, like the mic signal, can be routed in different ways through the RPx400. linoff disables
the line inputs from being being heard but dry line signal can still be recorded. lindry routes the left
and right line signals around the RPx400’s effects processing and mixes them in at the left and right out-
puts respectively. linrvb routes the line signals only through the RPx400 Delay and Reverb modules.
linefx sums the left and right line input signals together and then routes this signal through all of the
RPx400’s effects.

Line USB Source Mapping
The line input signals, as can be seen in the previous Line Signal Routing diagram, has two paths in which
they can travel up the USB port to the computer. Path A taps the line input signals off right at the line
input and sends unprocessed signal up to the USB port. Path B taps these signals at the output of the
RPx400 and can include any effects processing that may be used. Below is a matrix to show where the
signal is tapped based on how the Line, USB 1-2 Source, and USB 3-4 Source settings are
configured.
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Mic USB Source Mapping
Как видно из предыдущей диаграммы, сигнал микрофона поступает в USB-порт 
компьютера по двум направлениям. На Пути Е сигнал микрофона изолируется 
непосредственно на входе, после чего направляется на USB-порт без обработки. Путь 
С разделяет сигнал уже на выходе из RPx400, что позволяет добавлять к звуку любой 
набор эффектов. На схеме ниже показано место изоляции сигнала в зависимости от 
используемой конфигурации настроек Mic, USB 1-2 Source и USB 3-4 Source.

Направление линейного сигнала
Линейный сигнал, также как и сигнал микрофона, может быть пропущен через RPx400 
различными способами. В режиме LINOFF линейные сигналы не слышны, однако их 
можно записывать. В режиме LINDRY сигнал c левого и правого входов поступает 
на выходы, минуя обработку эффектами. LINRVB пропускает линейный сигнал через 
модули Delay и Reverb RPx400. В режиме LINEFX левый и правый сигналы суммируются в 
моно-сигнал, который может быть обработан всеми эффектами процессора.

Mic USB Source Mapping
The mic signal, as can be seen in the previous Mic Signal Routing diagram, has two paths in which it can
travel up the USB port to the computer. Path E taps the mic signal off right at the mic input and sends
unprocessed signal up to the USB port. Path C taps the signal at the output of the RPx400 and can
include any effects processing that may be used. Below is a matrix to show where the signal is tapped
based on how the Mic, USB 1-2 Source, and USB 3-4 Source settings are configured.

Line Signal Routing
The line signals, like the mic signal, can be routed in different ways through the RPx400. linoff disables
the line inputs from being being heard but dry line signal can still be recorded. lindry routes the left
and right line signals around the RPx400’s effects processing and mixes them in at the left and right out-
puts respectively. linrvb routes the line signals only through the RPx400 Delay and Reverb modules.
linefx sums the left and right line input signals together and then routes this signal through all of the
RPx400’s effects.

Line USB Source Mapping
The line input signals, as can be seen in the previous Line Signal Routing diagram, has two paths in which
they can travel up the USB port to the computer. Path A taps the line input signals off right at the line
input and sends unprocessed signal up to the USB port. Path B taps these signals at the output of the
RPx400 and can include any effects processing that may be used. Below is a matrix to show where the
signal is tapped based on how the Line, USB 1-2 Source, and USB 3-4 Source settings are
configured.
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Mic USB Source Mapping
The mic signal, as can be seen in the previous Mic Signal Routing diagram, has two paths in which it can
travel up the USB port to the computer. Path E taps the mic signal off right at the mic input and sends
unprocessed signal up to the USB port. Path C taps the signal at the output of the RPx400 and can
include any effects processing that may be used. Below is a matrix to show where the signal is tapped
based on how the Mic, USB 1-2 Source, and USB 3-4 Source settings are configured.

Line Signal Routing
The line signals, like the mic signal, can be routed in different ways through the RPx400. linoff disables
the line inputs from being being heard but dry line signal can still be recorded. lindry routes the left
and right line signals around the RPx400’s effects processing and mixes them in at the left and right out-
puts respectively. linrvb routes the line signals only through the RPx400 Delay and Reverb modules.
linefx sums the left and right line input signals together and then routes this signal through all of the
RPx400’s effects.

Line USB Source Mapping
The line input signals, as can be seen in the previous Line Signal Routing diagram, has two paths in which
they can travel up the USB port to the computer. Path A taps the line input signals off right at the line
input and sends unprocessed signal up to the USB port. Path B taps these signals at the output of the
RPx400 and can include any effects processing that may be used. Below is a matrix to show where the
signal is tapped based on how the Line, USB 1-2 Source, and USB 3-4 Source settings are
configured.
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Использование Pro Tracks
Для того чтобы компьютер определил RPx400 как прилагаемое устройство, после 
первого запуска программы Pro Tracks, необходимо установить конфигурации MIDI-
устройства и аудионастройки. Эта процедура необходима для того, чтобы в полной 
мере использовать все доступные функции записи RPx400 (в том числе hands-free 
возможности)

ПРИМЕЧАНИЕ: Прочитайте Инструкцию по установке программного обеспечения, прилагаемую к 
RPx400. Инструкция содержит информацию об использовании программы Pro Tracks, а также об 
установке USB-драйверов.

Установка программы Pro Tracks
Программа Pro Tracks должна быть установлена на ваш компьютер, чтобы в полной 
мере использовать звукозаписывающие возможности RPx400. Следуйте инструкциям 
согласно прилагаемому к диску Pro Tracks буклету.

Настройки MIDI-оборудования
Для взаимодействия с Pro Tracks RPx400 использует MIDI-команды. Они служат для 
определения выбранных настроек направления сигнала на выходах USB 1-2 и USB 3-4. 
Это способствует правильной работе программы Pro Tracks во время записи hands-free. 
Для конфигурации MIDI-настроек Pro Tracks необходимо:
1.	 Запустите программу Pro Tracks на вашем компьютере
2.	 Если появится окно Tip of the Day, закройте его кнопкой Close.
3.	 Если перед этим не были выбраны действующие MIDI-выходы, появится окно No MIDI Outputs 

Selected. Нажмите кнопку Choose MIDI Outputs Now. Появится окно MIDI Devices.
4.	 Выберите RPx400 USB MIDI из доступных вариантов настроек для входных и выходных каналов. 

Не следует выбирать DigiTech USB X-Edit и остальные варианты. Нажмите Move Selected De-
vices to Top.

5.	 Нажмите кнопку OK, после чего окно закроется.
6.	 Если появится окно Quick Start – нажмите кнопку Close.

Настройки RPx400 для hands-free записи
1.	 Выберите Options>Control Surfaces в меню Pro Tracks. Появится окно Control Surfaces.
2.	 Нажмите кнопку + для добавления новой Control Surface. Откроется окно Control Surface Set-

tings.
3.	 Во всплывающем меню Control Surface выберите DigiTech RPx. Убедитесь, что конфигурация 

входных и выходных портов по-прежнему настроена на RPx400 USB MIDI. В противном случае 
– следует настроить ее сейчас.

4.	 Нажмите кнопку ОК. После этого DigiTech RPx будет отображена как Connected Surface в окне 
Control Surfaces.

5.	 Нажмите кнопку Close.

Теперь, после синхронизации программы Pro Tracks с RPx400, появилась возможность 
выполнения автоматизированных функций записи.

Настройки Pro Tracks для RPx400 аудио
1.	 Выберите Options>Audio в меню Pro Tracks. Появится окно Audio Options. Нажмите на tab Driv-

ers.
2.	 Выберите в настройках драйверов входа (Input Drivers) DigiTech USB 1-2 In/Out и DigiTech USB 

3-4 In/Out. Отключите остальные опции.
3.	 Выберите в настройках драйверов выхода (Output Drivers) DigiTech USB 1-2 In/Out. Отключите 

остальные опции.



4.	 Нажмите кнопку ОК.
5.	 Нажмите кнопку ОК, когда изменения будут сохранены, перед перезапуском приложения.
6.	 Закройте программу Pro Tracks. Когда появится предложение сохранить изменения, нажмите 

No.
7.	 Перезагрузите Pro Tracks еще раз.
8.	 Закройте окна Tip of the Day и Quick Start если они появятся.
9.	 Выберите Options>Audio в меню Pro Tracks.
10.	 Убедитесь, что в конфигурации воспроизведения (Playback) и Recording Timing Master 

выбрано DigiTech USB 1-2 In/Out в качестве выхода по умолчанию. В противном случае – 
следует настроить конфигурации сейчас.

11.	 Нажмите на кнопку Wave Profiler на нижней панели.
12.	 Нажмите кнопку Yes для тестирования звукового оборудования.
13.	 Когда операция установки профиля завершится, нажмите кнопку ОК.
14.	 Если окно Audio Options все еще открыто – закройте его нажатием на кнопку ОК.

Теперь вы готовы использовать программу Pro Tracks в работе с RPx400.

ВНИМАНИЕ: Не отключайте RPx400 из сети и не отсоединяйте USB-кабель от компьютера во время 
работы программы Pro Tracks. Это может вызвать непредсказуемые сбои в работе компьютера.

3. Under the Output Drivers settings, select DigiTech USB 1-2 In/Out and deselect all other
options.

4. Click the OK button.
5. Click the OK buttonwhen the window stating changes will be saved upon re-start appears.
6. Close the Pro Tracks application. When you are prompted to save changed, click No.
7. Re-start the Pro Tracks application again.
8. Close the Tip of the Day and Quick Start windows if they appear.
9. From the Pro Tracks menu bar, select Options>Audio.

10. Verify that the Playback and Record Timing Master settings have DigiTech USB 1-2 In/Out select-
ed. If not, select these now.

11. Click the Wave Profiler button at the bottom.
12. Click the Yes button to continue performing the tests.
13. When the profiling operation is successfully completed, click the OK button.
14. Click the OK button to close the Audio Options window if it is still open.

You are now ready to use the RPx400 with Pro Tracks recording software.

CAUTION: Do not disconnect power or disconnect the USB cable from the RPx400 or the
computer while the Pro Tracks software is running. Doing so can result in unpredictable
behavior from your computer’s operating system.

Using the RPx400’s Footswitches for Recording
The RPx400’s footswitches are capable of controlling the Pro Tracks™ recording software, creating a hands-
free recording interface. To do this, the RPx400 must be connected to the computer via the included USB
cable and the Pro Tracks application must be installed and open.

Recording a Track or Tracks
To begin recording a track using the footswitches, follow these steps:

1. Start the Pro Tracks application.
2. From the Pro Tracks menu bar, select File>New. The New Project File window will appear.
3. From the New Project File window, select Normal - Hands-Free Session.
4. Put the RPx400 footswitches in Recorder mode by pressing and holding the UP and AMP A/B
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Использование напольных переключателей 
RPx400 при записи
Напольные переключатели RPx400 способны управлять звукозаписывающей программой 
Pro Tracks. Таким образом создается записывающий интерфейс hands-free. Для этого 
RPx400 должен быть подключен через USB-порт к компьютеру с установленным и 
работающим программным обеспечением Pro Tracks.

Запись дорожек
Для записи звука с использованием напольных переключателей необходимо:

1.	 Запустить программу Pro Tracks.
2.	 Выберите File>New из панели меню Pro Tracks. После этого появится окно New Project File.
3.	 Выберите пункт Normal – Hands-Free Session в окне New Project File.
4.	 Для перехода процессора в режим Записи, необходимо одновременно зажать 

переключатели UP и Amp A-B до появления на дисплее REC FS.



5.	 Чтобы войти в ряд настроек на матрице RPx400, удерживайте кнопку Select или нажмите на 
нее несколько раз.

6.	 Выберите источник записи, используя регулятор USB 1-2 Source (дополнительные источники 
назначаются регулятором USB 3-4 Source).

7.	 Нажмите на напольный переключатель RECORD. На дисплее появится RECORD. Начнется 
запись, а звуковые дорожки будут автоматически помещены в текущую сессию Pro Tracks.

8.	 Для остановки записи нажмите на напольный переключатель STOP/UNDO. Pro Tracks 
останавливает запись, а дисплей RPx400 показывает STOP. После остановки записи The wave 
data дорожки отображается на мониторе.

Воспроизведение записанной дорожки
После того как дорожка была записана, ее можно с легкостью воспроизвести. Если 
вы хотите воспроизвести записанное с начала или с любого другого места вам 
необходимо:
1.	 Нажать один раз на напольный переключатель STOP/UNDO. На дисплее появится REWIND, а 

Pro Tracks начнет перематывать записанную дорожку на начало
2.	 Нажать на напольный переключатель PLAY. После этого начнется воспроизведение 

дорожки.

Запись составных дорожек
После того, как дорожка записана, вы можете записывать поверх нее новые. Чтобы 
записать новую дорожку на уже имеющуюся необходимо:
1.	 В дисплее пресетов нажать и удерживать кнопку Select для входа в ряд настроек на матрице 

RPx400.
2.	 Выберите источники записи, используя регулятор USB 1-2 Source (дополнительные источники 

назначаются регулятором USB 3-4 Source).
3.	 Нажмите дважды на напольный переключатель STOP/UNDO для перемотки дорожки на 

начало.
4.	 Нажмите на напольный переключатель RECORD. На дисплее появится RECORD. Начнется 

запись, а звуковые дорожки будут автоматически помещены в текущую сессию Pro Tracks.
5.	 Нажмите на напольный переключатель STOP/UNDO для завершения записи.

Удаление дорожки с помощью напольного 
переключателя UNDO
Вы можете удалить последнюю записанную дорожку с помощью напольных 
переключателей RPx400. Для удаления дорожек необходимо:

1.	 Нажать и удерживать напольный переключатель STOP/UNDO. Надпись UNDO на дисплее 
покажет, что последняя записанная дорожка стерта из памяти.

Повторная обработка записанной гитарной дорожки
После записи необработанного гитарного сигнала, он может быть пропущен 
через RPx400 с целью повторной обработки. Это открывает широкие возможности 
для экспериментов со звуком. Вы можете подвергнуть записанный звук обработке 
эффектами, пропустить его через различные модели усилителей, а затем записать его 
отдельной дорожкой. Данная функция незаменима, это помогает, когда вы пытаетесь 
добавить новый звук в уже готовую песню, которую сложные установки эквалайзера 
могут попросту испортить. 



11.	 В ряде настроек выберите REAMP, используя регулятор USB 1-2 Source. После этого программа 
записи будет пропускать звук через модуль эффектов RPx400.

12.	 Нажмите на напольный переключатель PLAY. Вернитесь в Режим Выступления, удерживая 
одновременно переключатели Up и AMP A/B до появления UPDOWN на дисплее. После этого вы 
можете прослушивать имеющиеся пресеты, пока не найдете нужный вам. Затем необходимо 
вернуть напольный переключатель в режим Записи.

13.	 Нажмите на напольный переключатель STOP/UNDO для перемотки на начало дорожки.
14.	 Нажмите на напольный переключатель RECORD. После этого стерео-дорожка обработанной 

гитары запишется в текущий проект.
15.	 Для остановки записи нажмите на напольный переключатель STOP/UNDO.

Для повторной обработки сигнала необходимо:
1.	 Нажать переключатели UP и Amp A-B до появления на дисплее REC FS для перехода 

процессора в режим записи.
2.	 Выберите File>New в меню Pro Tracks. Откроется окно New Project File.
3.	 Выберите шаблон проекта Normal-Hands Free Session.
4.	 Выберите ряд настроек (Setup) на матрице RPx400.
5.	 Выберите DRYGTR регулятором USB 1-2 Source, регулятор USB 3-4 Source необходимо поставить 

на OFF.
6.	 Нажмите на напольный переключатель RECORD. На дисплее появится RECORD. Начнется 

запись, а звуковые дорожки будут автоматически помещены в текущую сессию Pro Tracks.
7.	 Нажмите на напольный переключатель STOP/UNDO для завершения записи. Дисплей RPx400 

показывает STOP, и запись останавливается. Нажмите еще раз на Stop для перемотки 
дорожки на начало.

8.	 В разделе Out записанной дорожки выберите B (DigiTech USB 1-2 In/Out).

To re-amp a track back through the RPx400, follow these steps:
1. Put the RPx400 footswitches in Recorder mode by pressing and holding the UP and AMP A/B

footswitches until the display reads rec fs.
2. From the Pro Tracks menu bar, select File>New. The New Project File window will open.
3. Select the Normal-Hands Free Session project template.
4. Select the SETUP row in the RPx400’s matrix.
5. Use the USB 1-2 Source knob to select drygtr and USB3-4 Source to off.
6. Press the RECORD footswitch. The RPx400’s display reads record. A track is automatically

inserted in the current session of the Pro Tracks software and recording on this track begins.
7. To stop recording, press the STOP/UNDO footswitch. The RPx400’s display reads stop and

recording will stop. Press Stop again to rewind to the beginning of the track.
8. In the Out box of the track you just recorded, select B(Digitech USB 1-2 In/Out).

9. In the tool bar press the Console View button to see the mixing console.

10. Pan the B - Mains Output hard left and the A - Mains Output hard right.

11. Select the SETUP row again and use the USB 1-2 Source knob to select REAMP. This configures
the recording software to playback audio through the RPx400’s effects processing.

12. Press the PLAY footswitch. Put the footswitches back to Performance mode by pressing and holding
the UP and AMP A/B footswitches simultaneously until the display reads updown. You can nowo
audition presets until you find one you like . Once you have done so, return to Recorder footswitch
mode.

13. Press the STOP/UNDO footswitch twice to rewind to the beginning of the track.
14. Press the RECORD footswitch and the recorder will now insert and record a stereo track of

processed guitar.
15. To stop recording, press the STOP/UNDO footswitch.
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9.	 В панели инструментов нажмите кнопку Console View для вывода на экран микшерской 
консоли.

To re-amp a track back through the RPx400, follow these steps:
1. Put the RPx400 footswitches in Recorder mode by pressing and holding the UP and AMP A/B

footswitches until the display reads rec fs.
2. From the Pro Tracks menu bar, select File>New. The New Project File window will open.
3. Select the Normal-Hands Free Session project template.
4. Select the SETUP row in the RPx400’s matrix.
5. Use the USB 1-2 Source knob to select drygtr and USB3-4 Source to off.
6. Press the RECORD footswitch. The RPx400’s display reads record. A track is automatically

inserted in the current session of the Pro Tracks software and recording on this track begins.
7. To stop recording, press the STOP/UNDO footswitch. The RPx400’s display reads stop and

recording will stop. Press Stop again to rewind to the beginning of the track.
8. In the Out box of the track you just recorded, select B(Digitech USB 1-2 In/Out).

9. In the tool bar press the Console View button to see the mixing console.

10. Pan the B - Mains Output hard left and the A - Mains Output hard right.

11. Select the SETUP row again and use the USB 1-2 Source knob to select REAMP. This configures
the recording software to playback audio through the RPx400’s effects processing.

12. Press the PLAY footswitch. Put the footswitches back to Performance mode by pressing and holding
the UP and AMP A/B footswitches simultaneously until the display reads updown. You can nowo
audition presets until you find one you like . Once you have done so, return to Recorder footswitch
mode.

13. Press the STOP/UNDO footswitch twice to rewind to the beginning of the track.
14. Press the RECORD footswitch and the recorder will now insert and record a stereo track of

processed guitar.
15. To stop recording, press the STOP/UNDO footswitch.
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10.	 Разведите  выходной сигнал по панораме (B – Mains Output до конца налево, A – Mains Output 
до конца направо)

To re-amp a track back through the RPx400, follow these steps:
1. Put the RPx400 footswitches in Recorder mode by pressing and holding the UP and AMP A/B

footswitches until the display reads rec fs.
2. From the Pro Tracks menu bar, select File>New. The New Project File window will open.
3. Select the Normal-Hands Free Session project template.
4. Select the SETUP row in the RPx400’s matrix.
5. Use the USB 1-2 Source knob to select drygtr and USB3-4 Source to off.
6. Press the RECORD footswitch. The RPx400’s display reads record. A track is automatically

inserted in the current session of the Pro Tracks software and recording on this track begins.
7. To stop recording, press the STOP/UNDO footswitch. The RPx400’s display reads stop and

recording will stop. Press Stop again to rewind to the beginning of the track.
8. In the Out box of the track you just recorded, select B(Digitech USB 1-2 In/Out).

9. In the tool bar press the Console View button to see the mixing console.

10. Pan the B - Mains Output hard left and the A - Mains Output hard right.

11. Select the SETUP row again and use the USB 1-2 Source knob to select REAMP. This configures
the recording software to playback audio through the RPx400’s effects processing.

12. Press the PLAY footswitch. Put the footswitches back to Performance mode by pressing and holding
the UP and AMP A/B footswitches simultaneously until the display reads updown. You can nowo
audition presets until you find one you like . Once you have done so, return to Recorder footswitch
mode.

13. Press the STOP/UNDO footswitch twice to rewind to the beginning of the track.
14. Press the RECORD footswitch and the recorder will now insert and record a stereo track of

processed guitar.
15. To stop recording, press the STOP/UNDO footswitch.
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Барабанные сэмплы RPx400 и MIDI
Сэмплы из драм-машины RPx400 могут быть трансформированы в MIDI-ноты 
и воспроизведены в Pro Tracks. Каждый барабанный паттерн процессора 
запрограммирован как MIDI-дорожка в файле библиотеки проекта записи Pro 
Tracks.

Барабанные сэмплы RPx400 прикреплены к MIDI-нотам следующим образом:
MIDI-нота                              Сэмпл
36/С3     …………………..     Бас-барабан
38/D3     …………………..     Малый барабан
42/F#3     ………………….    Закрытый хай-хет 
46/Bb3    ……………………  Открытый хай-хет 

Запись барабанов RPx400
Сигнал с драм-машины RPx400 может быть записан программой Pro Tracks. Все 
барабанные паттерны сохранены как файлы шаблонов паттерна в библиотеке 
проекта записи Pro Tracks. Это позволяет управлять барабанными сэмплами при 
последующем воспроизведении. Для записи барабанов с помощью файлов 
шаблонов паттерна Pro Tracks необходимо следующее:

1.	 Выберите File>New в меню Pro Tracks. Откроется окно New Project File.
2.	 Выберите один из барабанных шаблонов DigiTech RPx400 и нажмите кнопку ОК. Откроется 

новая сессия записи.
3.	 На RPx400 выберите DRUMS, используя регуляторы USB 1-2 Source или USB 3-4 Source.
4.	 Нажмите на напольный переключатель RECORD. На дисплее появится RECORD. Новая звуковая 

дорожка будет автоматически помещена в текущую сессию Pro Tracks. Все дорожки будут 
записаны.

5.	 Для остановки записи нажмите на напольный переключатель STOP/UNDO.

Вы можете использовать барабанные MIDI-файлы, пока они прикреплены к MIDI-
нотам, обозначенным выше. Барабанные сэмплы реагируют только на MIDI-сигналы, 
направляемые по 10 MIDI-каналу (по умолчанию для барабанов General MIDI).

Playback Mix
Регулятор Playback Mix позволяет сбалансировать звук, проходящий через RPx400, 
с аккомпанементом из Pro Tracks. Данная функция доступна только когда RPx400 
подключен к компьютеру во время работы программы Pro Tracks. Для изменения 
соотношения уровня звука сигналов RPx400 и аккомпанемента необходимо:

1.	 Начать воспроизведение сессии в программе Pro Tracks.
2.	 Поворачивайте регулятор Playback Mix для установления баланса между 
уровнем исходящего из RPx400 сигнала и уровнем громкости воспроизведения 
записанного аккомпанемента. Появление  на дисплее USBMIX 0 означает, что слышны 
сигналы только с RPx400. При повороте регулятора по часовой стрелке громкость 
аккомпанемента увеличится. При достижении 50-процентного соотношения 
сигнала RPx400 и аккомпанемента с компьютера на дисплее появится USBRPX50. 
При дальнейшем повороте регулятора по часовой стрелке уровень сигнала с 
RPx400 будет уменьшаться. При надписи RPXMIX 0 на дисплее слышен только сигнал 
аккомпанемента с компьютера.



Регуляторы USB 1-2 Level/USB 3-4 Level
Регуляторы USB 1-2 Level и USB 3-4 Level отвечают за подъем и срез уровня сигнала, 
поступаемого в компьютер через USB-порт. Необходимо использовать данную 
функцию, если сигнал входящего источника (микрофон, гитара, линейный источник) не 
оптимизирован под программу записи звука (с информацией о proper уровнях записи 
можно ознакомиться в Руководстве Пользователя Pro Tracks). Если сигнал воспринимается 
программой Pro Tracks  как слишком сильный, необходимо понизить его уровень с 
помощью регуляторов. Регуляторы USB 1-2 Level и USB 3-4 Level контролируют уровень 
звука для каждой из выходных пар USB. Например, если для источника USB 1-2 выбран 
параметр SUMMIC, вместе с повышением уровня микрофонного сигнала на USB 2 до 6 дБ 
будет также подниматься и уровень суммированного сигнала, идущего на USB 1 до 6 дБ. 
Для увеличения/уменьшения уровня сигнала, идущего в компьютер необходимо:

1.	 Play/sing проверьте уровень сигнала, поступающего в звукозаписывающее устройство 
(с информацией об отображении уровня поступаемого сигнала можно ознакомиться в 
Руководстве Пользователя Pro Tracks).

2.	 Используйте соответствующий регулятор для подъема или среза сигнала, идущего 
в звукозаписывающее устройство. Уровень сигнала можно изменять от -6 дБ (USB1-2-6) до 
+24 дБ (USB1-2 24).

Использование напольного переключателя RPxFC при записи

RPx400 имеет джековое гнездо для напольного переключателя. Это дает возможность 
подключить дополнительный переключатель RPxFC для управления записывающим 
процессом. Данный трехкнопочный переключатель выполняет функции воспроизведения, 
начала и остановки записи (PLAY, RECORD, STOP/UNDO). RPxFC – идеальное подспорье 
в записи. Его наличие позволяет задействовать переключатели RPx400 только для смены 
пресетов и каналов усилителя (amp channels), а процессами записи программы Pro 
Tracks управлять непосредственно с RPxFC. При подключении RPxFC к RPx400 используйте 
только 1/4” TRS стерео-кабель.

Функции RPxFC в точности дублируют функции переключателей RPx400 в режиме Записи. 
Ознакомьтесь с инструкциями в разделе Использование напольных переключателей 
RPx400 при записи.

USB 1-2 Level /USB 3-4 Level
The USB 1-2 LEVEL and USB 3-4 LEVEL knobs are used for boosting or cutting the amount of signal
sent out the USB port to the computer. These controls are to be used if the signal level of the input source
(mic, line, guitar) isn’t optimized into your recording software (consult the Pro Tracks User’s Guide for infor-
mation on proper recording levels). If the signal is too hot to Pro Tracks, use these controls to decrease the
level. The USB 1-2 Level and USB 3-4 Level knobs control the level for each USB pair of outputs so for
example, if summic is the selected USB 1-2 Source, increasing the level for the mic 6dB going up USB 2 will
also increase the summed signal by 6dB going up USB 1. To increase or decrease the level of audio going up
to the computer, follow these steps.

1. Play/sing through the RPx400 and check the level of signal reaching the recording software (consult the
Pro Tracks User’s Guide for information on how to view recording signal levels).

2. Use which ever USB Level knob to boost or cut the signal level going to the recording software. The
boost/cut range are -6db (usb1-2 -6) to +24dB (usb1-2 24).

Using the RPxFC for Recorder Functions

The RPx400 is equipped with a footswitch jack that lets you connect an optional RPxFC for controlling the
RPx400’s recorder. This 3-button footswitch features functions for STOP/UNDO, RECORD, and PLAY.
The RPxFC is an ideal companion for recording as it lets you leave your RPx400 footswitches setup for
changing presets and switching amp channels while the RPxFC is used specifically for controlling the Pro
Tracks recording software. Use only a TRS stereo 1/4” cable when connecting the RPxFC to the RPx400.

The RPxFC functions are exactly the same as the RPx400 footswitches when it is in Recording mode. Refer
to section Using the RPx400’s Footswitches for Recording for operating instructions.

FOOT CONTROLLERFOOT CONTROLLER

STOP/UNDO RECORD PLAY
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Utilities
Восстановление фабричных установок

Данная функция позволяет восстановить фабричные установки параметров 
процессора RPx400. После выполнения этой операции все сохраненные 
пользовательские пресеты будут потеряны, а Педаль Экспрессии разкалибрована.

ВНИМАНИЕ: Выполнение данной функции сотрет всю информацию, заданную пользователем. 
Убедитесь в том что действительно хотите сбросить все настройки из памяти процессора.

Для сброса текущих установок необходимо:
1.	 Выключить RPx400 из сети.
2.	 Подключить RPx400 к сети, удерживая кнопку Select.
3.	 Когда на дисплее появится RST ?, отпустите кнопку Select, а затем нажмите кнопку Store, 

фабричные настройки RPx400 будут восстановлены (дисплей отобразит RESET), после чего 
последует автоматический переход в меню Калибрации Педали Экспрессии. Выполните 
пункты 4-7 раздела Калибрации Педали Экспрессии.

Калибрация Педали Экспрессии
После восстановления фабричных установок необходимо откалибровать Педаль 
Экспрессии. RPx400 автоматически переходит в данный режим после сброса 
данных. При сбоях в работе педали или в случае неудачной ее калибрации можно 
использовать эту функцию без потери пользовательских настроек. Для этого 
необходимо:
1.	 Отсоединить сетевой адаптер PS0931B от процессора.
2.	 Подключить RPx400 к сети, удерживая переключатель Down.
3.	 Удерживайте переключатель Down до появления на дисплее CALIB (калибрация)
4.	 После появления на дисплее TOE DN – опустите Педаль Экспрессии.
5.	 Нажмите на любой переключатель. На дисплее появится TOE UP.
6.	 Поднимите Педаль Экспрессии.
7.	 Нажмите на любой переключатель. На дисплее появится VSWITCH. Произойдет переход в 

меню Чувствительности V-Switch.

Примечание: Если на дисплее появится сообщение об ошибке – необходимо повторить пункты 4-8.

Установки чувствительности V-Switch
Для изменения чувствительности V-Switch необходимо выполнить действия 4-7 из меню 
Калибрации Педали Экспрессии, а затем выполнить следующее:
1.	 После появления на дисплее VSWITCH опустите Педаль Экспрессии, а затем сильно надавите 

на нее до появления надписи DONE.
2.	 Когда на дисплее поочередно будут отображаться надписи DONE (с указанием числового 

значения чувствительности V-Switch) и VSWITCHON (или VSWITCHOf, в зависимости от того, 
включен режим V-Switch или нет), вы можете проверить уровень чувствительности V-Switch, 
нажимая на Педаль Экспрессии.

3.	 Поворачивайте Регулятор 5 для изменения значения чувствительности V-Switch. Нажмите на 
педаль, чтобы услышать новый уровень чувствительности.

4.	 После установки необходимого уровня – нажмите на любой переключатель. RPx400 перейдет 
в Режим Выступления, а ваши изменения автоматически сохранятся.



Решение возможных проблем.
При воспроизведении аудио-дорожки из Pro Tracks слышны щелчки
•	 Попробуйте настроить Wave Profiler в меню Options->Audio. Это должно устранить большинство 

неполадок. Также, попробуйте выбрать драйверы ММЕ в меню Driver Mode (Options->Audio-
>Advanced). Безопаснее всего использовать именно эти драйверы, однако кроме этого 
необходимо увеличить время задержки.

•	 Попробуйте увеличить время задержки в меню аудионастроек.

Запись hands-free неожиданно перестала работать или не работает совсем
•	 Если запись прервалась, попробуйте выйти из программы Pro Tracks а затем перезагрузите 

компьютер (не забудьте сохранить текущий проект).
•	 Подключите RPx400 к сети питания и только после этого запускайте программы Pro Tracks и 

X-Edit.
•	 Полное отсутствие записи свидетельствует о неисправностях в USB и MIDI-соединениях. 

Причиной, как правило, является неправильно установленные драйверы и/или файлы .dll, 
либо некачественный USB-кабель.

•	 Ознакомьтесь с разделом инсталляции драйверов.

Звук воспроизводимой дорожки Pro Tracks не слышен
•	 Если RPx400 находится в режиме «Reamp», попробуйте переставить его в другой режим 

(например «Stereo»).
•	 Убедитесь в том, что фейдеры программы Pro Tracks не находятся на нуле.
•	 Убедитесь в том, что звук воспроизводимых дорожек не выключен.
•	 В разделе Options->Audio->Drivers выберите в качестве драйвера входного канала ‘DigiTech 

USB 1-2 In/Out’ и отключите все остальные.
•	 Ознакомьтесь с разделом инсталляции драйверов.

Сигнал RPx400 не записывается программой Pro Tracks
•	 В разделе Options->Audio->Drivers выберите в качестве драйвера входного канала ‘DigiTech 

USB 1-2 In/Out’ и ‘DigiTech USB 3-4 In/Out’.Отключите все остальные драйверы.
•	 Убедитесь в том, что необходимые драйверы установлены.
•	 Ознакомьтесь с разделом инсталляции драйверов.
•	 Перед первой записью убедитесь в том, что RPx400 не находится в режиме «Reamp».

Повторного усиления записанного гитарного сигнала не происходит
•	 Ознакомьтесь с разделом Повторное усиление записанного гитарного сигнала данного 

Руководства.

Программа Pro Tracks периодически «зависает»
•	 Закройте все работающие программы, кроме Pro Tracks. Проверьте Диспетчер задач Win-

dows на наличие работающих скрытых программ.
•	 Попробуйте сократить количество выбранных плагинов и программных синтезаторов.
•	 Увеличьте объем памяти вашего компьютера.
•	 Установите жесткий диск с большим объемом.
•	 Не помещайте записанные аудио-данные на жесткий диск с операционной системой и 

приложениями.
•	 Используйте более мощный компьютер.
•	 Ознакомьтесь подробнее с системным требованиями программы. 

Куда отправляются записанные файлы?
•	 Записанные дорожки сохраняются в папке, заданной в Options->Global, Audio Data.

Звуковые дорожки звучат слишком громко/тихо
•	 Вы можете поднять или опустить уровень записываемого сигнала в меню контроля уровня 

USB 1-2 и USB 3-4.

Воспроизведение из программы Pro Tracks громче звука гитары
•	 Вы можете отрегулировать соотношение уровня громкости гитары и дорожки воспроизведения 

с помощью регулятора Playback Mix. 



При записи возникает неожиданный обрыв звука (dropout)
•	 Попробуйте увеличить время задержки в меню аудионастроек.
•	 Попробуйте сократить количество дорожек в вашем проекте (Не следует отключать звук 

дорожек. Необходимо либо заархивировать дорожки, либо удалить их).
•	 Закройте все работающие программы, кроме Pro Tracks. Проверьте Диспетчер задач Win-

dows на наличие работающих скрытых программ.
•	 Попробуйте сократить количество выбранных плагинов и программных синтезаторов.
•	 Увеличьте объем памяти вашего компьютера.
•	 Установите жесткий диск с большим объемом.
•	 Не помещайте записанные аудио-данные на жесткий диск с операционной системой и 

приложениями.
•	 Используйте более мощный компьютер.

Программа X-Edit не определяет RPx400 как устройство записи
•	 Убедитесь в том, что набор драйверов установлен правильно. Проверьте надежность USB-

соединения.
•	 Ознакомьтесь с разделом Установка USB-драйверов RPx400.

Во время воспроизведения записанной дорожки слышно ее дублирование
•	 Возможно, включен мониторинг входящего сигнала. Отмените его в меню Options->Audio-

>Input Monitoring.

Контроллеры настройки высоких, средних и низких частот не работают
•	 Когда RPx400 подсоединен к компьютеру, регуляторы настройки частот выполняют функции 

Playback Mix, USB 1-2 Level и USB 3-4 Level. В этом режиме настраивать частотность можно 
через программу X-Edit или через матрицу редактирования.

Сигнал микрофона не записывается
•	 Необработанный сигнал микрофона можно записать только отдельной дорожкой. Для 

записи с микрофона необходимо войти в режим настроек матрицы RPx400 и выбрать 
параметр MICDRY в настройках USB 1-2 Source и USB 3-4 Source.

Сигнал барабанов не записывается
•	 Сигнал драм-машины можно записать только отдельной дорожкой. Для записи барабанов 

необходимо войти в режим настроек матрицы RPx400 и выбрать параметр DRUMS в настройках 
USB 1-2 Source и USB 3-4 Source.

Линейный сигнал не записывается
•	 Необработанные линейные сигналы можно записать только отдельной дорожкой. Для 

записи сигналов с линейных входов необходимо войти в режим настроек матрицы RPx400 и 
выбрать параметр DRYLIN в настройках USB 1-2 Source и USB 3-4 Source.

•	 Линейный сигнал, обработанный эффектами, может быть записан вместе с гитарой. В 
настройках направления линейных сигналов необходимо выставить LINRVB либо LINEFX.

При смене пресетов во время записи/воспроизведения происходит обрыв звука 
(dropout)
•	 Смена пресетов во время записи может привести к обрыву линейного или микрофонного 

сигнала, поступающего в компьютер.

Программа Pro Tracks не запускается
•	 Возможно, это вызвано прерыванием USB-соединения во время предыдущей сессии Pro 

Tracks. Перезагрузите компьютер для устранения этой проблемы.

 Звук аккомпанемента с USB 3-4 не слышен
•	 Аккомпанемент поступает только на USB 1-2. USB 3-4 создан для записи дополнительных 

дорожек (гитара без обработки, сигнал микрофона, барабаны и т.п.)



Приложение
Спецификация
Входные гнезда:
Гитарный вход: 1/4” несбалансированный
Микрофонный вход: XLR сбалансированный с 
фантомным питанием
Линейные входы: 1/4” сбалансированные TRS
CD/Мониторный вход: 1/8” стерео TRS
Вход напольного переключателя: 1/4” стерео TRS
USB 1.1

Выходные гнезда
Линейные выходы: 1/4” несбалансированные
Линейные выходы: XLR сбалансированные
Выход наушников: 1/8” стерео TRS
USB 1.1

A/D/A:
24 bit Delta Sigma Converters

Драм-машина:
30 паттернов + метроном

Возможность одновременного использования 
эффектов:
до 11 эффектов

Потребляемая мощность:
10 Вт

Потребление энергии:
675мA переменного тока

Сетевое питание:
9 VAC, 1300mA
Сетевые адаптеры:
Digitech PS0913B – 100 (100V ~ 50/60 Гц)
Digitech PS0913B – 120 (120V ~ 60 Гц)
Digitech PS0913B – 230 (230V ~ 50 Гц)
Digitech PS0913B – 240 (240V ~ 50 Гц)

Пресеты:
40 пользовательских
40 артистических (заводские)
40 заводских

Эффекты:
Симулятор датчика, Wah, Моделирование 
усилителя/акустической гитары, Трехполосный 
эквалайзер, Шумоподавление, Auto Swell, Pluck 
Gate, Моделирование гитарного кабинета, 
Расположение микрофонов, Chorus, Flange, Trig-
gered Flange, Phaser, Triggered Phaser, Tremolo, Pan-
ner, Vibrato, Rotary Speaker, AutoYa™, YaYa™, Synth-
Talk™, Envelope Filter, Pitch Shift, Detune, Whammy™, 
Delay, Reverb.

Габариты:
21,6 см. 33 см. 5,7 см.

Вес:
2,1 кг


